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Chapter1
Creating Reports

You can create reports in a visualization in Db2 Web Query Designer similar to the way in
which you create charts. Reports allow you to communicate information at a high level of
detail using a familiar tabular format. You can create a stand-alone report in a
visualization, or combine multiple reports in a page.

In this chapter:

Adding Filters to a Visualization

Adding Headers and Footers to Content

Setting Conditional Styling Based on
Data Values

Changing a Field Format

Creating Calculations

Using Prefix Operator Aggregation
Functions

Using Dynamic Grouping for Dimension
Field Values

Creating Numeric Ranges With Binning

Enabling Field Selection at Run Time
With Field List Parameters

Enabling Hierarchical Drilling in Db2 Web
Query Designer With Auto Drill

Enabling Drill Anywhere to Analyze Field
Relationships

Enabling Automatic Content Linking in
Db2 Web Query Designer With Auto
Linking

Adding Drill-Down Links to Content

Changing Output Formats in a Chart or
Report

Generating a Data Extract or Image From
Content

Previewing Content

Adding Filters to a Visualization

As you create charts and styled tabular content in Db2 Web Query Designer, you may want to
narrow the display of information that is shown. You can do this by creating filters for fields in
your data source. You can also use filters as a way to create custom displays of the data that
you show in your content. For example, you may only want to show revenue information for
specific product categories and models in a given year, or for product categories that exceed a
certain revenue value.
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Filters in Db2 Web Query Designer can utilize one of two behaviors: static and prompted
filtering. Static filters are applied to individual content items at design time, and allow you to
apply consistent filter values to a chart or report. Prompted filters, on the other hand, allow
users to select the filter values to use in your content at run time. When you create a new
prompted filter, it affects all new content on the page. In addition to adding prompted filters to
new content, when existing content using a prompted filter is added to a page, you can create
automatic filter controls that can be used at run time. Any content that uses the same
parameters can be filtered using the same control. These controls are not generated for static
filters.

To create a static filter for a selected field, drag it from the Fields tree on the Resources panel
to the Filter bucket, which is located below the field container buckets on the Properties panel
when you select a content item. When you create a static filter, the Add Filter dialog box
appears, as shown in the following image.

You can select filter values and the relationships those values have to the data that you want
to display in your chart or report. Static filters can only be created for new content.

Adding Filters to a Visualization
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You can add prompted filters to a visualization using new or existing content in one of the
following ways:

When creating new content, drag a data field to the Filter toolbar below the page toolbar.

When creating new content, right-click a data field and click Add to filter toolbar.

When creating or interacting with new content, select one or more sections of a chart by
clicking or lassoing them, then click Keep.

When creating or interacting with new content, use the filter options in the In-Document
Analytics menu on the column of a report.

When creating a visualization from existing content, add an item that uses dynamic
parameter filters to the visualization.

Click the resulting label on the Filter toolbar to open a control, from which you can select
default filter values. Users will be able to change the selected value at run-time.

Adding Static Filters to Content

Filters allow you to limit the data that displays in your content, making it easier to find useful
information by removing extraneous data values. You can create prompted filters, which allow
users to select the filter values to use in your content at run time, or you can create static
filters, which are always applied to your content whenever it is run. Prompted filters allow you
to create controls when the content that uses them is added to an assembled page, while
static filters do not. Additionally, prompted filters affect all new content on the page, or any
referenced content that uses the filter. Static filters, on the other hand, affect only the item for
which the filter was created.

Static filters are a good choice when you want the same filter values to be applied to your
content at all times, or want to create a filter that only affects a single content item.

To create a static filter, when creating a new chart or report, drag a field into the Filters bucket
on the on the Settings tab of the Properties panel. The Add Filter dialog box opens, and
presents options relevant to the type of field that you are filtering.

These options also differ depending on whether you are filtering compared to selected values
or to another field. You can change this option by setting the Compare to option to Value or
Field.

1. Creating Reports
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When you set the Compare to option to Value you can filter alphanumeric fields using the
following options:

Select values. When using the Value comparison type, select the values that will be used
to define the filter.

Select from data. Search for and select values from the data source used in your
content.

Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Wildcard. Manually type a single string that you can use to select multiple filter values.
You can specify that the values in your content should start with the string, end with the
string, or contain the string at any point. Wildcard value filtering is case-sensitive. You
cannot use a wildcard filter value at the same time as specified values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.

Adding Filters to a Visualization
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The Add Filter dialog box when filtering an alphanumeric field is shown in the following image.

When you set the Compare to option to Value, you can filter numeric fields using the following
options:

Select values. Select the values or field that will be used to define the filter.

Select ranges. Provides options to specify a range of values for your filter. When
selecting data ranges, you can apply an aggregation option to use when filtering the
selected field. Use None to filter on data values before aggregation, or use a different
aggregation to filter on sorted values, aggregated by the selected operation. For
example, use Summary to filter by measure values summed for each sort value. For
more information, see Summarizing Numeric Data Using Filters on page 32.

Single value. Select a filter operator, then filter for all values before or after a
selected start or end point. You can select a value using the slider or type a value
into the text box.

1. Creating Reports
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Range of values. Set a static range of values to use for the filter. Select a start and
end point using the slider or text boxes, and set filter operators for each.

You can type a value that is outside the range of values in your data. In this case, the
text box displaying the value is outlined in purple and a message indicates that the
value is out of range.

Select from data. Search for and select values from the data source containing the
filter field.

Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.

Adding Filters to a Visualization
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The Add Filter dialog box when filtering a measure field is shown in the following image.

When you set the Compare to option to Value, you can filter date fields using the following
options:

Select values. Select the values or field that will be used to define the filter.

Select ranges. Provides options to specify a range of dates for your filter.

Single date. Filter for all dates before or after a selected start date or end date, by
selecting a filter operation and a date value.

Range of dates. Set a static range of dates to use for the filter by selecting a start
and end date and setting filter operators for each.

Select from data. Search for and select values from the data source containing the
filter field.

1. Creating Reports
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Click Load values from data to display all available values from the selected field in the
left list. Select one or more values and click Add to add them to the list of selected filter
values on the right. To remove a value from the list of selected filter values, select one
or more values and click Remove. You can also click Clear List to remove all selected
values.

Select from file. Allows you to pull data values from a file on your system. You can
select a delimited flat file, such as a CSV file, or an Excel spreadsheet from which to
import values for selection. These values are taken from the first column of the file.
This option can be an easy way to select a large number of values that are found in
another data source.

Click Load values from file to select a data file and display all available values from it in
the left list. Select one or more values and click Add to move them to the list of
selected filter values on the right. To remove values from the list of selected filter
values, select one or more values and click Remove, or click Clear List to remove all
values.

Enter manually. Type a value and click Add or press the Enter key to move it to the list
of selected filter values on the right. Multiple values must be typed separately. You can
also choose whether or not to include missing or blank values in the filter. To remove a
value from the list of selected filter values, select one or more values and click Remove,
or click Clear List to remove all selected values.

Exclude. Available when using the Value comparison type. When the Exclude check box is
selected, the values selected for the filter are excluded from the request. When cleared,
which is the default state, the selected values are included.

Adding Filters to a Visualization
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The Add Filter dialog box when filtering a date field is shown in the following image.

Set the Compare to value to Field to filter the selected field in relation to another field in the
request. For example, you could use this filter to identify values for which the revenue was less
than the cost of goods sold. When filtering by compared field values, the following options are
available:

Source aggregation. Available only for numeric fields. Select an aggregation option to use
for filtering the selected field. Use None to filter on data values before aggregation, or use
a different aggregation to filter on sorted values, aggregated by the selected operation. For
example, use Summary to filter by measure values summed for each sort value.

Operator. Set the relationship that will define how the filter is applied. Options are:

Equal to. Values display in your content if they match the specified filter values.

Not equal to. Values display in your content if they do not match the filter values.

Greater than or equal to. Values display in your content if they match the selected
filter values, come after them alphabetically, or have a higher numeric value.

1. Creating Reports
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Greater than. Values display in your content if they come after the selected filter
value alphabetically or have a higher numeric value.

Less than or equal to. Values display in your content if they match the selected filter
value, come before it alphabetically, or have a lower numeric value.

Less than. Values display in your content if they come before the selected filter
value alphabetically or have a lower numeric value.

Compare aggregation. Select an aggregation to apply to the field that the selected field
is being compared to. Use None to compare to data values before aggregation, or use a
different aggregation to compare to sorted values, aggregated by the selected
operation. For example, use Summary to compare values from the selected field to
values in the comparison field summed for each sort value.

Compare field. When using the Field comparison type, provides a list of fields in your
data source. Values from the field for which you are creating the filter are compared to
those in the comparison field and filtered out based on the selected operator.

The Add Filter dialog box when filtering a numeric field by comparison to another field is shown
in the following image.

Adding Filters to a Visualization
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Adding Prompted Filters to a Visualization

As you create charts or styled tabular content in Db2 Web Query Designer, you may want to
narrow the display of information that is shown. You can do this by creating filters for data
fields in your content. You can also use filters as a way to create custom displays of the data
that you show in your content. For example, you may only want to show revenue information for
specific product categories and models in a given year.

Prompted filters can be created for external content added to a page, in which case any
parameters in that content can be added as filter prompts, or for new content, in which case
the filter affects all new content on the page.

When you add filtered content to a page, you can open the Filters tab on the sidebar and click
Add all filters to page to add the filters to the page automatically, providing interactive controls
that your users can choose from to change the view of data available to them. Filtered content
can also be kept stand-alone, and you can choose to enable parameter prompting, which
requires a user to make a selection before the content displays. There is no limit to the
number of filters that you add, however, as you add more than five filters, all filters may not fit
on your screen. If you are using a carousel filter layout, used for prompted filters added to new
content, you can use the arrow control to scroll over to see any filters that are not visible in the
Filter toolbar, as shown in the following image.

If you are using a columnar layout, which is used for a visualization assembled from existing
content, then filters are split into additional rows as they exceed the number of columns on the
page, as shown in the following image.

You can add prompted filters to a chart or styled tabular content in one of the following ways:

When creating new content, drag a data field to the Filter toolbar below the page toolbar.

When creating new content, right-click a data field and click Add to filter toolbar.

1. Creating Reports
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When creating or interacting with new content, select one or more sections of a chart by
clicking or lassoing them, then click Keep.

When creating or interacting with new content, use the filter options in the In-Document
Analytics menu on the column of a report.

When creating a visualization from existing content, add an item that uses dynamic
parameter filters to the visualization.

Note: You can add data fields to the filter toolbar even if you do not have it displayed in your
view.

You can remove filters from the filter toolbar by clicking the X in the upper-right corner of the
filter, or by right-clicking the filter and then clicking Delete.

You can create a maximum of one filter per measure field, and a maximum of two filters per
dimension field, for individual dimension field values and for an aggregation of the dimension
field. The aggregation of a dimension field can be a count, count of distinct values, or a
percent of count. You can create an aggregated dimension filter by adding the dimension to
your content as a measure, right-clicking the aggregated field in a measure bucket, and then
clicking Add to filter toolbar. If you right-click a field that already has a filter and click Add to
filter toolbar, or drag it into the filter toolbar, the existing filter control expands for you to select
filter values.

Adding Filters to a Visualization
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Once you have created filters, you can click them to select default data values and set
selection options for each filter. For example, when you create a filter using a dimension, it
lists the available data values. You can then select the default filter values, as shown in the
following image.

By default, no values are initially selected in the list control, which means that all values are
displayed by default. To select default values, you click the filter control, and begin clicking the
data values that you want to use as the default, then click outside the filter control area to
apply the selection.

If you select one or two values, each selected value is listed by name in the filter control. If you
select three or more values, the filter control shows the number of values selected out of the
total number of available values. If no values are selected, the filter control says All. All
available filter values are reflected in your content. If you select all listed values or click Select
all, then the filter indicates that n of n values are selected. If the values in the field change in
the data source, then the filter does not dynamically update to include them like it would if no
values had been explicitly selected.

The selected values are displayed in the chart at run time by default, and users can select
other values to display them.

1. Creating Reports
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Note: In charts, reports, and visualizations with new content, drop-down list controls and slider
controls using the Detail option have a record limit of 5000 values. Values beyond this limit
are not available for selection in the filter control. There is no record limit for filters in
visualizations assembled from existing content, calendar controls, or slider controls using a
summary aggregation.

When multiple prompted filters for alphanumeric dimension fields are created in a visualization
created with new content, they are chained in all directions, by default. This means that the
selection from one prompted filter control automatically filters and updates the available
values in the other controls, so they only display relevant values. This ensures that you cannot
select filter values that result in no data displayed in the visualization. You can change the
chaining setting from multidirectional chaining to hierarchical chaining, or turn chaining off,
from the Filter options menu.

In pages assembled from existing content, chaining is unidirectional, applied only to filters
lower in the chaining hierarchy than the filter for which you selected values. Filters for fields in
the same hierarchy are chained automatically, and you can drag a field onto another field in
the filter list in the Filters tab to manually make it a child of that filter for chaining purposes.
For more information about filter chaining in new content and pages assembled from existing
content, see Chaining Filter Control Selections on page 24.

When creating prompted filters for new content, you can choose to exclude data values from
the list. To do this, right-click the filter and select Exclude. You can then click the filter control
again, and begin clicking the data values that you want to exclude from the list. Once you have
selected the data values that you want to exclude, your chart refreshes.

At run time, instead of choosing which values to display in the chart, users select values to
exclude from the chart.

You can also set a prompted filter for new content to use a single value instead of multiple
values. If you right-click a prompted filter for new content and click Single, when you click the
filter control again, you are only able to select a single value. In filters for existing content, you
will have already defined whether or not the filter is multiselect or single-select.

Adding Filters to a Visualization
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If you add a filter using a numeric field, such as a measure, (for example, Cost of Goods), you
can use a slider to adjust the range of data values that display, as shown in the following
image.

Click the filter, and use the slider options on either side to modify the range of data values.
You can set a range using both ends of the slider. To select a single value, set both ends of
the slider to the same value.

The filter for a numeric field is applied after aggregation by default. That means that the filter
is applied based on summed values for all sort values in the chart instead of filtering each row
of the data source before aggregation. You can right-click a new prompted filter and point to
Aggregation to select a different aggregation operation, or select Detail to apply the filter to
each row before aggregation. For more information, see Summarizing Numeric Data Using
Filters on page 32.

If you right-click a new numeric filter and select Greater than or equal or Greater than, you can
select a minimum value for the filter range. The upper limit on the slider is fixed and cannot be
moved. Selecting Greater than or equal includes the value indicated by the slider in the filter,
while selecting Greater than excludes this value. Similarly, if you right-click a numeric filter and
select Less than or equal or Less than, you can select a maximum value to display. The lower
limit on the slider is fixed and cannot be moved. Selecting Less than or equal includes the
value indicated by the slider in the filter, while selecting Less than excludes this value. The
slider displays the greater than (>), less than (<), greater than or equal to (≥), and less than or
equal to (≤) symbols to differentiate your choices.

Note: Selecting the full range of values in the slider includes all values in the filter. The value
indicated by the slider head is not excluded in this case, even if the Greater than or Less than
filter options are used.

1. Creating Reports
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If you add a date field, you can use the date picker window to select a start or end date, range
of dates, and more, as shown in the following image.

You can use a default range available in the list on the left, or select your own range of dates
from the calendar. Click the same date twice to select a single day.

If you right-click a new date filter and select After or Before, you are unable to select a range
using either the preset or custom range options. Instead, use the calendar to select a start or
end date for the filter.

Similar to filtering a numeric field, you can right-click a date filter control and click On or after
or On or before, as an alternative to After or Before, to include the start or end date selected in
the calendar. The After and Before options do not include the selected date in the date range
of the filter.

In addition to the options specific to each type of filter, you can make the filter required. When
a filter is required, filtered content will not load until the user makes a selection for that filter.
To make a prompted filter for new content required, right-click the filter and click Require
selection. To make a prompted filter for existing content required, select the filter control and,
on the Settings tab of the Properties panel, clear the Optional check box.
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You can right-click a filter control for existing content on a page to access formatting options.
For example, you can convert a list control to radio buttons, check boxes, or a button pane,
merge two related controls, and access configuration and format options on the Properties
panel. For more information, see Styling Filter Controls in a Visualization on page 57.

Filtering a Chart with Visual Selections

You can visually create prompted filters by selecting areas of a chart directly from the canvas
as you create it, as well as at run-time. This is called on-chart filtering. Since on-chart filtering
is performed based on visual selections on a chart, they are quick and intuitive to create. On-
chart filters created from one item immediately affect all other content created on the page,
allowing you to see the impact of your filter immediately. On-chart filtering is available from
pages containing one or more new content items, and from stand-alone charts created using
the AHTML output format.

On-chart filtering is enabled in applicable content types by default. To disable on-chart filtering,
open the Filter options menu and deselect Use content as filters.
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To use on-chart filtering, select one or more areas of a chart by clicking a single section or by
clicking and dragging, or lassoing, an area of the chart. The selected sections of the chart are
highlighted, and a tooltip appears with information about the selected area, as shown in the
following image.

From the tooltip, you can filter the entire visualization for the data that you selected in the
chart. Click Keep to create a prompted filter for the selected values, or click Exclude to create
a filter that excludes the selected values.
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You can create several filters using on-chart filtering to further refine the data that you display
in the visualization. Each of these filters affects every item on the page. When a filter is
created, it is added to the Filter toolbar. If the filter applies to a single dimension, you can click
the filter label in the toolbar to edit it. If the filter is applied to multiple dimensions, such as a
bar chart with one dimension in the Horizontal bucket and another dimension in the Color
bucket, then the filter is not editable from the Filter toolbar. However, you can point to it to see
a tooltip listing the filter selections, as shown in the following image.

You can right-click the filter label at design time to delete the on-chart filter or swap between
keeping and excluding the selected values. You can also delete a filter created with on chart
filtering by selecting an area of the chart and clicking Remove Filter on the tooltip, or by clicking
the X on the filter control in the Filter toolbar. The visualization restores the values previously
hidden by the on-chart filter.

On-chart filtering works similarly at run time. When you run a page created with new content,
you can click or lasso different areas of a chart to dynamically filter the entire page.
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Chaining Filter Control Selections

When a content item or page includes multiple filters, chaining ensures that those filters
always return valid values to your content. When you select a value from one of the filter
controls, the other controls can be filter and updated based on the value that you select, if
chaining is applied. For example if you have a filter for Sale Quarter chained to a filter for Sale
Month, then when you select Q1 from the Sale Quarter filter, the Sale Month filter updates to
show only the months of January, February, and March, and automatically excludes any month
values that were not in Q1.

Two different chaining behaviors are available: multidirectional and hierarchical. When multiple
prompted filters for alphanumeric dimension fields are created in a visualization created with
new content, they are chained multidirectionally, by default. This means that the selection from
one prompted filter control automatically filters and updates the available values in all other
controls for alphanumeric fields, so they only display relevant values. This ensures that users
cannot select filter values that result in no data displayed in the visualization, regardless of the
order and arrangement of the filter controls. To select a value that has been hidden because of
chaining, clear any other filters that may have resulted in the value being unavailable. Note
that on-chart filtering also affects the available filter values when multidirectional chaining is
enabled.
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For example, the following image shows a chart with multidirectional filter chaining enabled.
Notice that, since the filter for Sale Day was set to 31, only months with 31 days are shown in
the drop-down list for Sale Month.

If you make selections in one filter control, and then make selections in another chained filter
control that make some of the original values unavailable, those originally selected values are
restored when the other filters are cleared. For example, if you set the Sale Month filter to
September and December, and then set the Sale Day to 31, September is no longer visible in
the Sale Month control, since it only has 30 days. Only December is selected. When you clear
the Sale Day control, both September and December are selected once again in the Sale
Month control.

Full multidirectional chaining is only applied to list controls. Calendar and slider controls are
not chained. While slider controls and preset ranges in calendar controls update to reflect the
current range of data, similar to chaining, the values selected using a slider or calendar do not
affect the other controls.
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You can change the chaining setting for filters in the page to hierarchical chaining or no

chaining by clicking the Filter options menu  and selecting Link hierarchies or Do not link
filters, respectively. The option to change chaining behavior is only applicable to stand-alone
content or content created within a visualization.

Hierarchical chaining is based on drill levels in your metadata. When you select a filter value,
chaining is applied to fields that are lower in the same filter hierarchy. Filter controls for fields
that are higher in the same hierarchy are not affected by filter selections when using
hierarchical chaining, nor are filter controls for fields that are not in the same hierarchy.

Hierarchical chaining is the default behavior for filter controls that are added to a page from
external content. When external content is added to a visualization, hierarchical chaining is
applied automatically to any content with WHERE filters using a WITHIN phrase. Db2 Web
Query Designer automatically adds the WITHIN phrase to filters from the same metadata
hierarchy, so hierarchical chaining is enabled for content items created in Db2 Web Query
Designer by default when they are added to a page as external content.
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When assembling a page from existing content, you can manually apply hierarchical chaining
relationships to filter controls from the Filters tab on the sidebar, even if those fields are not
part of the same metadata hierarchy. The Filters tab shows a list of all parameters in your
assembled page. The order of this list does not impact filtering behavior, but the parameter list
does indicate chaining hierarchies, which display as values indented below their parent value.
Drag a parameter in the list on the Filters tab onto another parameter to make it a child of that
filter control. You can create a multi-level chaining hierarchy so that selections from one filter
apply chaining to a second filter, and selections from the second filter apply chaining to a third
filter. The following image shows the parameter list with a selection of filters that have been
added to a page assembled from existing content.

In this example, the filter selections in the Customer Business Region filter are chained to the
Customer Country and Customer State Province fields, so if you select North America as the
business region, then only countries and provinces in North America will be available from the
other respective filter controls. Since hierarchical chaining is unidirectional, if you select a
country for the Customer Country filter, the Customer Business Region is not affected, so you
could still select a business region other than the one that contains the previously selected
country.
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Filters from multiple data sources used for content in an assembled page can be chained
together, although if the field name and values of parent filters do not exist in the data source
used for the child filter, chaining will not work properly. To unchain a parameter, drag it into the
empty space between the Add all filters to page button and the top parameter in the list. The
parameter is removed from the chaining hierarchy and moved to the bottom of the list.

Applying Prompted Filters From External Content

Importing a filter from external content in Db2 Web Query Designer is a quick and intuitive
process. Additionally, parameter filters added to a page from existing content can be
rearranged and styled with options unavailable to filters created for new content in a page.

Whenever you add a parameterized content item to the canvas, such as a chart or report that
uses a prompted filter or dynamic parameter, the parameters are recognized and you can
create filters for them automatically. A badge count is overlaid on the Filters tab on the
sidebar, as shown in the following image.

The Filters tab provides options to add filters to your page and apply chaining to them. Open
the Filters tab and then click Add all filters to page to create filters for all identified parameters.
Alternatively, right-click a parameter in the list to create a single filter control. Each filter in the
list on the Filters tab displays the filter name and, under Bindings, the data source and target
items associated with the filter. Available filter values are pulled from the data source, and the
selected values are passed to the target items. Chaining is indicated by tabbed hierarchies on
the Filters tab, and can be applied manually by dragging one filter onto another in the list.

After you add filters from external content to a page, you can right-click a filter control to
access formatting options. For example, you can convert a list control to radio buttons, check
boxes, or a button pane, merge two related controls, and access configuration and format
options on the Properties panel.

You can interact with the filter controls in an assembled page at design time to see how
different filter selections affect your content. However, these filter selections are not retained
at runtime. To change the default value for a filter in an assembled page, select the filter and,
on the Settings tab, in the Data Settings section, type a value into the Default value text box.
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As an alternative to using the Filter toolbar, or in addition to it, you can also add a grid
container to a page assembled from existing content by dragging it from the Resources panel
when you select the Container tab on the sidebar. A grid container includes multiple cells into
which filter controls can be placed. You can also move the original filter toolbar or have it
display in a modal window by selecting the entire page and then clicking one of the filter
location options on the Settings tab of the Properties panel.

To see which filters apply to which external content items, in addition to the binding
information on the Filters tab, click Info on the Visualization toolbar. Each content item on the
page lists the parameters by which it is filtered. The chart displayed in the following image is
affected by filters for six fields, listed under Parameters/Filters.

Procedure: How to Add Filters From Existing Content to a Page

When you bring existing, parameterized content into a page, you are prompted to create filter
controls for each parameter. Once created, these controls can be modified with a set of
additional options that are not available when creating new content items.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub or the Db2 Web Query Home
Page, click the plus button and then click Assemble Visualizations.

Db2 Web Query Designer opens in a new browser tab.
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2. In Db2 Web Query Designer, select a template for the page. You can use a predefined
template, or select Blank to build the page from scratch.

3. With the Content tab selected on the sidebar, drag a parameterized item of your choice
from the Resources tree to the canvas.

A badge appears on the Filters tab icon on the sidebar, indicating that there are unbound
filters.

4. Optionally, add more content.

Note: The quickest way to create stand-alone content featuring the same set of
parameters is to start by creating a Reporting Object with desired parameters, and then
using the Reporting Object to create content. To do so, on the Db2 Web Query Hub, click
the plus menu and click Create Visualizations, or on the Db2 Web Query Home Page, click
Visualize Data. When Db2 Web Query Designer opens, select a Reporting Object as your
data source.

5. Click the Filters tab on the sidebar. Click Add all filters to page to create controls for all
listed parameters, or right-click each parameter for which you want to create a filter
control, and click Add to page.

The filter bar appears above your content with the controls that you chose to create.

6. Optionally, customize your filter bar as described below.

Change the location of the filter bar from below the page toolbar to above it, to the left
side of the page, or into a modal window. Select the entire page and, in the Properties
panel, on the Settings tab, select Below Header, Above Header, Left Position, or Modal.

Move filter controls to a filter grid. When assembling a page from existing content, you
can create a filter grid by dragging a grid container from the Resources panel with the
Container tab selected. You can then resize and reposition the filter grid to customize
where the filter controls should display on your page.

Right-click a cell to access shortcut menu options, as shown in the following image.
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To right-click a cell, right-click the margin above or to the left of a filter control.

The available options are:

Insert row above. Inserts an empty row above the current row in the filter grid.

Insert row below. Inserts an empty row below the current row in the filter grid.

Format. Opens the Properties panel to the Format tab, where you can customize
the grid style and cell alignment.

Delete cell. Deletes the current cell.

Delete grid. Deletes the entire filter bar.

Right-click a control to access shortcut menu options, as shown in the following image.

The available options are:

Edit label. Selects the label text for editing.

Note: Another way to edit a control label is to double-click the filter label, type the
new text, and press the Enter key.

Convert. Opens the Convert Control To dialog box, where you can choose between
various control types.

You can convert a list control, created for alphanumeric fields, to radio buttons if
single-select, check boxes if multiselect, or a button panel. You can convert a
single-headed slider, created for single-select numeric fields, to an input box.

Settings. Opens the Settings tab of the Properties panel, where you can customize
control configuration options.
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Format. Opens the Format tab of the Properties panel, where you can customize
control styling options.

Delete control. Removes the filter control from the visualization.

Drag any filter cell to a new location in the grid to reposition or reorder the filter
controls.

Multi-select two related controls, right-click one of them, and then click Combine to
combine the two controls into one. An example of two combined controls is shown in
the following image.

The Combine option only applies to single-select date and numeric slider controls. They
can be combined into a single control with a start and end point.

Drag a control into a cell with other controls. This action puts two separate controls
into one cell. The drag marker is shown allowing you to position one controls in front or
behind another control. You can separate the controls again by dragging one control
out of the cell.

7. Save your changes.

Summarizing Numeric Data Using Filters

When you create a filter for a measure field in new content, you can choose to filter by
aggregated values, using a Summary filter, or by individual records, using a Detail filter. This
enables you to review data from a high level or based on a more granular view.
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To specify one of these options in a new prompted filter, when you place a measure on the
Filter toolbar, right-click it and point to Filter on to access the Detail and aggregated filter
options, which are shown in the following image.
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To choose between detail and aggregated filter options when creating a static filter, drag a
measure to the Filter bucket and select an option from the Apply aggregation drop-down menu.

Summary filters are indicated by an aggregation prefix operator on the filter control label.

The Summary option, which is the default for measure fields, allows you to select records
based on the summed, aggregated value of a field. All values for the chart, report, or page are
calculated, and then the aggregated values are filtered based on whether they meet the filter
requirements. For example, if you create a chart that shows Revenue sorted into Product
Categories, you can use a summary filter to display only the Product Categories that meet the
selected filter requirements.

If you create a new summary filter in a visualization with multiple content items, the minimum
and maximum values available in the filter control are the minimum and maximum values
across all combined sort fields in the entire visualization. For example, if you created a chart
that was sorted by Product Category, and then added a second chart that was sorted by Sale
Year and colored by Sale Quarter, then the values in the summary filter would reflect the range
of values for each product category and each combined sale year and sale month. In the
following image, the minimum available value for the summary filter on the Revenue field is
11,047,133, which is the revenue from Q1 2014 in the bar chart on the right. This is the
smallest value on the page. The maximum available value, 291,294,934, is the revenue for
stereo systems in the pie chart on the left. This is the largest value on the page.
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All of the other values in the pie chart and the bar chart on the page fall between these two
points. As a result, certain summary filter selections may exclude all values from one chart,
but not another.

You can also filter using Detail values, which represent each record of your data source. In this
case, filtering occurs before the values are calculated for each sort value. If you create a chart
that shows Quantity Sold sorted by Product Category and add a Detail filter, the individual
record values from the data source are filtered based on whether they meet the filter
requirements, and then sorted into product categories and aggregated to display the quantity
sold for each.

Consider the following two charts, each of which uses a filter for Revenue greater than
$10,000. The first chart uses a Summary filter, so it is filtered after aggregation. It displays
Revenue values for every product category that had over $10,000 in total revenue. Each of the
seven product categories met this criterion, and are therefore displayed in the chart, as shown
in the following image.
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In the second chart, the Summary filter has been changed to a Detail filter where Revenue is
greater than $10,000. This filter is applied before data aggregation. Since each record in the
data source represents a single sale, the data is filtered for individual sales that earned
revenue of over $10,000. Those values are then grouped by Product Category into the chart
shown in the following image.

In this case, the only individual sales for more than $10,000 were for camcorders and
televisions.
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In addition, when working with numeric filters, you can select the type of aggregation to be
used in a Summary filter. By default, a Summary filter, created using the Summary option,
uses the sum aggregation. You can also apply standard aggregation methods including
average, count, count distinct, minimum, and maximum to a Summary filter. Selecting one of
these options filters your content for aggregated values matching the specified criteria,
indicated by the label on the filter control, as shown in the following image of a filter control
using the average aggregation method.

If you create a filter for a field in your chart or report that already uses a prefix operator
aggregation, by dragging the field from a bucket to the filter toolbar or by right-clicking it in a
bucket and clicking Add to filter toolbar, a Summary filter is created with the prefix operator
aggregation applied.

If the field with the prefix operator is a dimension field, which can use the count, count
distinct, or percent of count prefix operator aggregations, then you can create two filters for the
field, one for the non-aggregated dimension field and one for the aggregated version of the
field.

If your request produces a single aggregated value before applying a Summary filter, such as
when there are no sort values, the filter control shows a single Summary value instead of
providing a range. If you point to the filter value on the Filter toolbar, a tooltip appears that
says, Summary filter irrelevant. Change to Filter on Detail or add a sort field to your request.

If you create a Summary filter and then changes are made to the request such that the
minimum or maximum value on the Summary filter range falls outside the range of values in
your data, then that filter value appears in red in the control. If you point to it, a tooltip
indicates that it is outside the range of your data. The filter is still valid, but may not be
applicable to the current state of your content. Similarly, when creating a static filter, you can
type a value that is outside the range of values in your data. In this case, the text box
displaying the value is outlined in purple and a message indicates that the value is out of
range.

1. Creating Reports

Creating Reports  37



If you create a numeric range in a static filter where the minimum value is greater than the
maximum value, the filter is not valid, and you cannot save it. A warning appears alerting you
that the start and end points are invalid.

Working With Required Parameters

By default, when you create a prompted filter in Db2 Web Query Designer, the filter is optional.
You can right-click a new prompted filter and select Require selection, or select a prompted
filter for existing content and clear the Optional check box on the Settings tab to make it
required. This means that users must select a value at run-time before affected content on the
page loads. Required controls from external content are marked in red, prompting you to make
a selection for the request to be processed. The image below shows an example of a required
filter control.

Procedure: How to Convert an Optional Filter Control in an Assembled Page to a Required One

1. In Db2 Web Query Designer, add filters to a page, as described in Applying Prompted
Filters From External Content on page 28.

2. Select an optional filter control and open the Settings tab on the Properties panel.

Be sure to select the filter control itself. If you click just outside the filter control, you will
select the cell containing the control, which can also be styled and formatted.

3. In the Control Settings area, clear the Optional check box to make the control required.
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The filter control is marked in red and the Make a selection text displays inside the control
field.

4. Optionally, to change the default text from Make a selection to a prompt of your choice,
change the value of the Placeholder text setting on the Properties panel.
The default text in the required control changes.

5. If the filter was created for an alphanumeric field, on the Settings tab, in the Data Settings
area, disable the Show All option setting.

6. Click the Run in new window button.

Your content opens in a new browser tab or window. The content affected by the filter
does not initially load. You must select a filter value first.

7. Select a value for the required filter control.

The content refreshes to reflect your selection.

8. Return to Db2 Web Query Designer and save your changes.

Working With Single and Multiple Select Lists

In Db2 Web Query Designer, list controls are created for alphanumeric fields and numeric
dimension fields. There are two types of list controls in Db2 Web Query Designer:

Single Select List. Allows you to pick a single value at run time.

Multiple Select List. Allows you to pick multiple values at run time.
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An example of a single select list control is shown in the following image.

Once you have made a selection in a single select list, your content instantly refreshes to
reflect that selection.
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An example of a multiple select list control is shown in the following image.

Once you have made all your selections in the multiple select list, you must click outside of the
control for the content to refresh.

If the prompted filter was created in a visualization with new content, you can switch between a
single and multiple list control by right-clicking the control and selecting Single or Multiple. If
the prompted filter was created for external content, the parameter on which it is based is
already defined as single- or multiselect.

List controls for new content include a search feature to make it easy to select the filter values
you want to use. To add or remove the search box for a filter for external content in an
assembled page, select or clear the Search check box on the Settings tab of the Properties
panel. Once search is enabled in the control, simply start typing any word or syllable and all
values that contain it will display.
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If a list contains 200 or more values, the paging feature is added to the bottom of the control.
When paging is active, 10 values display per page. An example of a long list with the paging
feature enabled is shown in the following image.

List controls for new content also include the Select all and Clear buttons. These are especially
useful when you need to eliminate just a few values from your results. You can click Select All,
clear the values that you need to eliminate, and click outside of the control to refresh your
content. These can also be added to multiselect list controls for existing content by selecting
the Selection controls option on the Settings tab.

Once you've typed a search term, you can use the Select all button to select all search results,
as shown in the following image.
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Note that the Select All option selects all values in the control. If the control does not contain
all field values, then those values won't be included in the filter. Additionally, the filter
selection will not update to include new values added to the data source. To ensure that all
values for the selected field are included in the filter, clear the filter selection. All displays on
the filter control, indicating that all values are used in the filter.

Dropdown list controls in pages assembled from existing content can be converted into
different types of controls that offer similar functionality. You can convert a multiselect list to a
checkbox control, double list control, or a button set, and you can convert a single-select list to
a radio button control, toggle control, or a button set.

Note: In charts, reports, and visualizations with new content, drop-down list controls and slider
controls using the Detail option have a record limit of 5000 values. Values beyond this limit
are not available for selection in the filter control. There is no record limit for filters in
visualizations assembled from existing content, calendar controls, or slider controls using a
summary aggregation.

Working With Double List Controls

Another common type of control for alphanumeric fields is a double list control. You can select
items in the full list of values on the left, and add them to the list of selected values on the
right. The double list control also includes the option to reorder the selected values. This can
be especially useful when using multi-select field list parameters in an InfoApp, allowing you to
change the order of sort and measure fields in the parameterized content. The only other type
of control that includes this reordering behavior is the check box control when you select the
Allow reordering option. The double list control is available only for alphanumeric, multi-select
parameter filters.
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Double list controls can be added to pages assembled from existing content. To add a double
list control to your page, add an external chart or report that is filtered by an alphanumeric,
multi-select parameter, and add the default drop-down list control to the Filter toolbar or a grid
container. Right-click the control, click Convert, and then select Double List. A text box that
displays the default filter value or values appears in the filter grid. Click the text box to open
the double list control, as shown in the following image.
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To apply filter values, first select the values in the list on the left that you want to use by
selecting the check box for each one. Selected values in the list are shown as checked. Select
the check box for a selected value again to deselect it. You can select multiple consecutive
values by holding the Shift key and clicking the check box for two values. You can select all
available values by clicking the check box in the list header, and deselect all values by clicking
it again. When more than 50 values are present in the list, it is divided into multiple pages of
25 values each. To navigate to a specific value, filter the list by typing a text string into the
search bar. When you have selected the values that you want to use in the filter, click the right

arrow button  to move them to the list of applied filter values on the right. You can also
double-click a single value to move it from one list to the other. Click outside of the double list
control to apply the filter selection.

You can reorder the applied values by using the up and down arrow buttons  in the
control, or by dragging an item up or down within the list on the right. When the double list
filter control is used in a multi-select field list parameter, this allows you to change the order in
which user selected fields appear in dynamic content. For example, you can use the double list
control with a multi-select field list parameter to swap the primary and secondary sort fields in
a report, placing focus on different values. To create a multi-select field list parameter, click
Add Parameter Field List in the Filters area of the Settings tab, and then, in the Add Parameter
Field List dialog box, set the Control type to Single select. For more information, see Enabling
Field Selection at Run Time With Field List Parameters on page 126.

To remove one of the applied filter values, open the double list control and double-click a value
in the list on the right, or select the values in the list on the right and click the left arrow button

. You can also click Clear List to immediately remove all applied filter values.
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Working With Slider Controls on a Page

A slider control is a horizontal track with a marker or markers that you can slide between a
minimum and maximum value. This versatile control is often used to choose a numeric value
within a fixed range. An example of a slider control is shown in following image.

Procedure: How to Create a New Slider Control Using Db2 Web Query Designer

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add a dimension field and, optionally, a measure field to your chart.

If there are no dimension values in the chart by which to aggregate the numeric values on
the slider, a tooltip indicates that slider selections are not relevant.

4. Drag a measure field into the Filter toolbar.

A slider control appears, allowing you to select default values for the filter parameter, as
shown in the following image.
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5. Set the default range of values for the filter.

6. Optionally, right-click the control on the Filter toolbar and click Greater than, Greater than
or equal, Less than, or Less than or equal to select only the minimum or maximum value
for the filter.

When a parameter using one of these options is added to a page in Db2 Web Query
Designer, the control is a slider with a fixed start or end point.

Working With Date Controls

Parameters that contain dates are recognized by Db2 Web Query Designer as date controls.
You can filter date fields by setting start and end points to create a date range. When setting a
date range, you can choose from a number of relative pre-defined date ranges, or set a fixed
custom date range using a calendar control. Click the same date twice to set the date range to
a single day.The calendar control and pre-set date range options are shown in the following
image.
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Once you have set the date range, click OK to apply the filter, or click Reset filter to clear the
filter and include all available dates in your content. Click Cancel to close the date control
without making any changes to your filters.

Date ranges set in Db2 Web Query Designer are actually based on two parameters, one for the
start date and one for the end date. As a result, when you add content created in Designer
with a prompted date filter to an assembled page, each of the controls is associated with a
distinct parameter. One parameter uses the Greater Than WHERE condition, the other
parameter uses the Less Than WHERE condition. If you add each date filter parameter to the
page separately, the start and end date each use separate filter controls. If you add all filters
to the page at once, they are combined automatically. An example of separate start and end
date controls for external content on the page is shown in the following image.
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When assembling a page from existing content and add the date filters separately, you can
still manually combine the two date controls into a single date range control. To do so, multi-
select two date controls, right-click one of them, and then click Combine. An example of a
combined date range control is shown in the following image.

When creating new content with a date filter, the date control is automatically a combined
control that allows you to select a date range.

The calendar feature inside a date control allows you to select a specific date value. Once you
pick a specific date, it is always spelled out, so that it can be supported by all internationalized
applications.

1. Creating Reports

Creating Reports  49



Setting a Time Zone in Date-Time Controls

Fields that include both the date and a timestamp, as opposed to just the date, are
considered to have a date-time format. Date-time fields are considered a separate field type
from regular date fields. You can filter a date-time field to the millisecond, depending on the
precision of the field format used for the field, allowing granular start and end points for date-
time ranges.

When you filter a date-time field in a chart, report, or authored page in Db2 Web Query
Designer, you are presented with the ability to change the time zone in addition to the regular
date filtering options, allowing you to filter content based on your local time zone. When you
set a time zone as part of a date-time filter, content is filtered to show data, which may have
recorded in a different time zone, based on whether it would fall within the defined date range
in your current time zone. For example, if the data was recorded in Greenwich Mean Time,
which is UTC±0 during standard time, and you set the time zone for your date range to a
location that uses Eastern Standard Time, which is UTC-5, then the filtered data begins at
5:00 AM on the first day of the range. This is because 5:00 AM in UTC±0, which is used as
the time zone where your data originated, is the same time as midnight in Eastern Standard
Time, the time zone that you selected for the filter. The start time for the filtered date range is
shifted based on the difference between the two time zones. The data values displayed in your
content do not change when you change the time zone used in your filter, and are assumed to
have been written from a time zone with an offset of UTC±0.
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When you create a prompted or static filter for a date-time field in a chart, report, or page in
Db2 Web Query Designer, you are presented with the ability to set a time range and change
the time zone in addition to the regular date filtering options. When you select ranges for a
static filter or use the Custom range option for a prompted filter, you can set a time range to
provide more granular start and end points for the selected date range when using a date-time
field. The start time is applied to the start date, and the end time is applied to the end date.
You can set start and end times precise to the millisecond level, or choose not to set a time
range by clearing the Apply time range check box. To set a time range using the filter control
for a date-time field, when creating new content or running an assembled page, open the
control and click Custom. Spinners to set the hour, minute, second, millisecond, and half of
the day using a 12-hour system appear below the calendar, as shown in the following image,
and you can also type numeric values into them.
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The available time components depend on the format of the date-time field being filtered. The
following image shows the date-time filter control for a field with a format of HYYMDI, which is
precise to the minute level. As a result, only hour and minute time components are available to
set.

Once you have set the start and end date and time for your filter, click OK on the filter menu to
apply it. To reset the filter to include all available values, open the filter menu, click Reset
filter, and then click OK

In some cases, however, the time values in your data may have been recorded in a different
time zone than the one in which you are currently located. You can change the time zone that
is applied to the filter to adjust the filtered data based on the time difference between your
location and the location from which the data was recorded. When you set a time zone as part
of a date-time filter, content is filtered to show data, which may have recorded in a different
time zone, based on whether it would fall within the defined time and date range in your
current time zone.
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For example, if the data was recorded in Greenwich Mean Time, which is UTC±0 during
standard time, and you set the time zone for your date range to a location that uses Eastern
Standard Time, which is UTC-5, then the filter that would start at 12:00 AM if the time zone
were not changed instead begins at 5:00 AM when the time zone is set. This is because 5:00
AM in UTC±0, which is used as the time zone where your data originated, is the same time as
12:00 AM in Eastern Standard Time, the time zone that you selected for the filter. The start
time for the filtered date range is shifted based on the difference between the two time zones.
The data values displayed in your content do not change when you change the time zone used
in your filter, and are assumed to have been written from a time zone with an offset of UTC±0.
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To apply a time zone to a your filter, drag a date-time field into the Filter toolbar or Filters
bucket. In addition to the range options that are also available for date fields, a Time Zone
option appears, with the default time zone selected, if one has been set on the Reporting
Server. To set the time zone for a prompted filter, click the Time Zone menu, as shown in the
following image.
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To set the time zone for a static filter, click the Time Zone option, as shown in the following
image.

Click the Time Zone menu or Time Zone option to open the Time Zone panel, shown in the
following image.

If no default time zone has been set, select the Apply a time zone check box to enable time
zone selection. You can select time zones for locations sorted by country or territory, on the
Time zones tab, or based on the UTC offset, on the Time Offsets (UTC) tab.
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To select a time zone based on a location, on the Time zones tab of the Time Zone dialog box,
first select a country or territory from the Country drop-down list. You can start typing the name
of a country or territory to navigate to it more quickly. Once you select a country or territory, a
list of available location-based time zones in that country appears, as shown in the following
image.

Select a location and then click OK on the filter menu to apply it.

Time zones based on locations automatically apply daylight savings, depending on the time of
year. For example, the North American Eastern Time zone has a UTC offset of UTC-5 during
standard time, and a UTC offset of UTC-4 during daylight time.

When applying a time zone to a date range filter for a date-time field, your data is interpreted
as having been written from a time zone with an offset of UTC±0. This is the offset during
standard time for the Western European Time time zone, during daylight savings time for the
Azores and part of Greenland, and year-round for Iceland and most of West Africa. Therefore, if
your data comes from a different original time zone, it is recommended to use a UTC offset
equivalent to the time difference between the time zone where the data originated and your
current time zone. For example, if your data originated in Los Angeles, and you are currently
located in New York, then you can select an offset of UTC+3 to see content with date-time
data from Los Angeles, filtered based on a start time of midnight in the New York since the
time zone for New York is three hours ahead of the time zone for Los Angeles.
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To select a UTC offset instead of a location-based time zone, click the Time Offsets (UTC) tab
and select an option. Click OK on the filter menu to apply the new time zone.

Once you set your time zone, select a date range for your filter and apply it. Your content
refreshes, and the hour at which your date range starts and ends is adjusted based on the
selected time zone.

If you create a page with multiple date-time parameter filters, the same time zone is applied to
all of them. When you select a time zone for one filter, an alert appears to inform you that it
will also be applied to other date-time filter controls on the page.

If you set a time zone and then want to revert to the default, open the Time Zone dialog box
and click Reset filter, then set the start and end date and time again. If you decide you do not
want to apply time zone adjustments at all, open the Time Zone dialog box, clear the Apply a
time zone check box, and then click OK.

You can set the default time zone in the locale settings of your reporting server. On the Db2
Web Query Hub, click Management Center and select Server Workspaces. Alternatively, In the
Server Console, click the Tools menu and click Workspace. Click the Settings menu, point to
LOCALE, and then click LOCALE (Language, Numbers, Currency, Dates). Type the default time
zone name into the TIMEZONE field. The time zone should use the IANA tz database name,
which typically use a format similar to Region/City_Name. For more information, see the List of
tz database time zones on Wikipedia.

Styling Filter Controls in a Visualization

When creating a page from external content, you can configure the properties of the filter
toolbar, a filter grid panel, or single filter control by using the Properties panel, which is
context-sensitive. For example, when you click a filter cell on the toolbar or in a filter grid, the
cell style properties open in the Properties panel. When you click a filter control within a cell,
the configuration and style properties for this control open in the Properties panel. You can
access properties for the entire Filter toolbar or a filter grid by selecting it from the outline.
When creating a page from new content, a smaller set of options are available for a filter
control or for the filter toolbar.
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The Properties panel consists of the Settings tab and the Format tab. The Settings tab
includes options to configure the behavior of the Filter toolbar, a filter cell, or a filter control.
The Settings tab on the Properties panel for a filter control created for external content is
shown in the following image.
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When you select the entire page, if it was assembled from existing content, you can change
the position of the filter toolbar using the following options:

Include Page Filters. Select this check box to add a filter toolbar to the page, even if no
filters have been added yet. Clear this check box to remove the filter toolbar.

If Include Page Filters is selected, you can select one of the following options to change the
position of the filter toolbar:

Below Header. The filter toolbar is placed below the page toolbar and header. This is
the default.

Above Header. The filter toolbar is placed above the page toolbar and header.

Left Position. The filter toolbar is aligned vertically along the left side of the page, below
the page header.

Modal. The filter toolbar is accessible in a modal window overlaid onto the page. Click
the Show filters button on the page toolbar to open the modal window and make filter
selections.

When the Filter toolbar or a filter cell is selected, the Settings tab includes two properties:

ID. Contains a read-only unique CSS identifier.

Classes. Allows you to add one or more custom CSS classes that you can reference in
custom JavaScript and CSS code.

Filter controls created within a page have different configuration and styling options than filter
controls added to the page from referenced, external content. When you select a filter control
that you created directly within the page, the Settings tab contains the following properties:

General Settings. This section includes the following options:

Type. Displays the type of the control.

ID. Contains a read-only unique CSS identifier.

Classes. Allows you to add one or more custom CSS classes that you can reference in
custom JavaScript and CSS code.

Tooltip. Displays a tooltip when you hover over the filter control.
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When you select a filter control that was generated from external content using the Filters
tab on the sidebar, the Settings tab contains the following additional property:

Global name. Designates a global name to the control, allowing you to synchronize
control values on different pages in a portal. For more information, see Using Global
Name to Synchronize Filter Controls on page 68.

Control Settings. This section includes the following options:

Optional. Toggles between optional and required control.

Allow reordering. If selected, allows you to reorder values inside the control at run time.
The default order is alphabetical. This property is only available for check box controls.

Placeholder text. Enables a configurable placeholder text that you can show users
inside a required control when it has no value. The default text is Make a selection. This
property is only available for drop-down list controls.

Note: The Placeholder text property is only used for required controls. The placeholder
text appears before a selection has been made. To change the default text for an
optional control, if the Default value for the control is _FOC_NULL, meaning all values,
enable the Show All option property and type a value for the Display text property. The
Display text option in the control represents the _FOC_NULL, or all values, filter value.

Search. Adds a search field to the filter drop-down menu. This option is available for
drop-down list, check box, and radio button controls.

Note: If the select list contains 50 or more values the Search option is enabled
automatically.

Selection controls. Adds Select all and Clear buttons to the filter drop-down menu. This
property is only available for multiple select lists and check box controls.

Note: The Selection controls and Show All options cannot be selected at the same time.

Data Settings. This section includes the following options:

Show All option. Adds an All option to the control that the user can select.

Note: Choosing this option results in the parameter receiving a _FOC_NULL value. If this
parameter is used in a WHERE condition, it results in the WHERE condition being
removed from the request and all data values for this field displaying the page.

Display text. Allows you to specify a custom value for the Show All option in the control.
The default text is All.
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Note: The Display text property is available when Show All option is selected. The
display text option in the control represents all values. To supply a placeholder value for
required controls that appears before a selection is made, use the Placeholder text
property.

Default value. Displays the default value of the control. For optional parameters you can
edit this field and override the control value.

The following options are available for toggle controls only:

Label One. Is the label that displays on the left side of the toggle control.

Value One. Is the actual filter value represented by the label on the left side of the
toggle control. This is the default value of the toggle control.

Value Two. Is the actual filter value represented by the label on the right side of the
toggle control.

Display label two. Allows you to hide or show the label on the right side of the toggle
control. Hiding the label saves horizontal space, but provides less information to users.

Label Two. Is the label that displays on the right side of the control. This label only
appears if the Display label two check box is selected.

Parameters. Shows the name of the parameters that are associated with this control.

When creating a visualization using external content, the Format tab of the Properties panel
provides layout and styling options for the Filter toolbar, a filter cell, or a filter control. These
options differ depending on the origin of the filter and the item selected. Format options are
not available for new prompted filters created in a visualization.
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The Format tab of the Properties panel, for the filter bar on the Filter toolbar or in a grid
container, is shown in the following image. You can use these options to change the layout of
the cells in the Filter toolbar or grid container, and change the theme style it uses.

The Format properties for a bar are:

Grid Type. Controls the grid layout of the filter bar. The options include 1-Column, 2-
Column, 3-Column, 4-Column, and 6-Column.

When you are using a columnar layout and the number of filters exceeds the number of
columns, the extra filter controls are added to new rows in the Filter toolbar. In the carousel
layout, you can use the arrows on either side of the Filter toolbar to scroll to additional filter
controls.
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Grid Style. Controls the style of the filter grid. The available styles are defined in the theme
used for the page. When you select a style for a cell, the entire Filter toolbar is affected.

The Format tab for a cell is shown in the following image.

When you configure these properties, you modify the alignment of a control or other object
within a cell. Cell format properties are only available for cells in the columnar grid or toolbar
layout used in a visualization with external content. The cell and filter control in the carousel
style layout used in a visualization with new content are not separate components, so the cell
cannot be selected for formatting.

The properties for a filter cell are:

Cell Content Alignment. Controls the alignment of the label and control inside the cell. The
options include top, middle, bottom, left, center, and right. These options are available
when using a columnar filter grid layout.
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The Format tab for a filter control created for external content is displayed in the following
image. You can modify the positions of labels in a control, define the alignment, and set the
object width.

The style properties for filter controls in a page with external content are:

Label Position. Controls the position of the filter label in the relation to the control. The
options are above, right, left, and no label.

Label Alignment. Controls the alignment of the filter label. The options are left, right, and
center.

Direction. Controls the alignment of the elements inside the control. This property is
available for radio button, check box, and button set controls. The options are horizontal
and vertical. The vertical option is enabled, by default, when the control has five or more
values.

Label/Control Split. Controls the space ratio between the label and control inside the cell.
This option is only available when the label position is set to right or left.

Control Object Width. Sets the width of the control in relation to the filter cell. The options
are:

Auto. Adjusts the width of the control automatically to accommodate the name of each
value.
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Max. Fills the entire filter cell. This is the default value.

Percentages. Set the control width to various percentages, as they relate to the filter
cell.

Control Object Height. Sets the maximum height of the control. If the list of elements
exceeds the maximum height of the control, a scrollbar is added to this control. This
property is available for radio button, checkbox, and button set controls when their
Direction property is set to vertical. The default value is 150px. You can change this value
as necessary.

Prompted filter controls created in a visualization with new content always use a predefined,
simple filter style. No format options are available for these controls.

Choosing an Event Model for Your Page Filter

When assembling a visualization from existing content, Db2 Web Query Designer supports two
event models for passing parameters to your page content:

On-selection Change. Whenever you change a value of any filter control on the page,
parameterized content refreshes to reflect your selection. This model is enabled, by
default.

Submit Button. After you make all desired changes to filter controls on the page and click
the Submit button, parameterized content refreshes to reflect all your selections. This event
model also allows you to use a Reset button to revert all filters to their default values. This
model can be enabled by dragging a Submit button from the Control tab on the sidebar into
the filter grid. Submit and Reset buttons appear, as shown in the following image.

You can delete the Submit button to use the on-selection change event model for your
filters, but still retain the Reset button, and you can also delete the Reset button to keep
only the Submit button on the page.

Procedure: How to Use On-selection Change Filters

1. Add filters to a page as described in Applying Prompted Filters From External Content on
page 28.
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2. Click the Run in new window button.

Your content opens in a new browser tab or window, allowing you to interact with content
and filters. If your page content contains default values, page filters and page content run
in parallel, which results in a faster loading time.

3. Make filter selections.

Each time you make a selection, the content refreshes to reflect it.

Note: Notice that, if you have parameters that come from the same field hierarchy in your
data source, the filter controls are chained in such a way that each selection automatically
reflects the available choices in other filters. In our example, we set Category to
Televisions. Now, the Product Model filter only shows models of televisions, as shown in
the following image. Db2 Web Query Designer chains controls automatically, if the
parameters are defined in the metadata layer with the WITHIN keyword to relate them.

4. Return to Db2 Web Query Designer and save your changes.

Procedure: How to Use Filters With a Submit Button

1. Add filters to a page assembled from existing content, as described in Applying Prompted
Filters From External Content on page 28.

2. From the Resource selector, click the Controls tab, and then drag the Submit button onto
the filter grid. This can be the filter grid in the Filter toolbar, or in a grid container.

The Submit and Reset buttons display in the filter grid.
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3. Optionally, customize the Submit and Reset buttons in any of the following ways:

Align the Submit and Reset buttons by selecting the cell in which the buttons reside
and customize the Cell Content Alignment option on the Format tab of the Properties
panel. In this example, we selected Align control bottom and Align control center.

Add a tooltip to the buttons by selecting each one and populating our the Tooltip field
on the Settings tab of the Properties panel.

Customize the width of the buttons in relation to the filter cell by selecting one of the
options under the Control Object Width property. In this example, we selected 50%.

Note: You can delete one or both buttons by right-clicking them and clicking Delete.

4. Click the Run in new window button.

The content runs in a new browser tab or window, allowing you to interact with content and
filters.

5. Make filter selections. Your parameterized content does not update immediately.

6. Click Submit.

The content refreshes to reflect all your selections upon clicking the Submit button, as
shown in the following image.

7. Click Reset.

The filters return to their default values.

8. Optionally, click Submit again to refresh the content with the default values.
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Note: If you deleted the Reset button, you must select default values manually, and then
click Submit to return to the default state. Alternatively, you can click the refresh button on
the page toolbar to refresh all content and filter controls on the page.

9. Return to Db2 Web Query Designer and save your changes.

Using Global Name to Synchronize Filter Controls

The Global Name property is a powerful tool that allows you to quickly synchronize filter control
values between different pages. The Global Name property is configured on the Settings tab of
the Properties panel for a filter control in an assembled page. Once enabled, it allows you to
match your filter selections across multiple pages at run time within the same browser
session. This option is especially useful in a portal. The global name can be used to
synchronize filter control selections across multiple pages in the same portal.

Procedure: How to Configure Global Name Filter Control Property

1. In Db2 Web Query Designer, add filters to a page using existing content, as described in 
Applying Prompted Filters From External Content on page 28.

2. Click a filter control that you want to synchronize.
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3. On the Properties panel, in the Settings tab, populate the Global Name field, as shown in
the following image.

Note: You can choose any text as a global name for your control. Combined controls, such
as date ranges and slider controls, have a single global name property.

4. Optionally, repeat step 3 for all the filter controls that you want to synchronize.

5. Save the page.

6. Create a second page, populate it with parameterized content, and add the same set of
filter controls as you did in step 1.

Note: To streamline this process, you can use the Save As option to create a new version
of the existing page, leave the configured filters intact, and replace the content on the
canvas. Make sure the Global Name values are identical between the filter controls on
both pages.

7. Save the second page and exit Db2 Web Query Designer.

8. Run one of your newly created pages.

9. Select filter control values.
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An example of the filter control selections is shown in the following image.

10. Run the second page.

The page runs with the same filter control values as the ones you have selected on the
previous page, as shown in the following image.

Note: If your page was created uses the Global Name feature and contains default
content, you must save it again using Db2 Web Query Designer to ensure optimal
performance.
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11. Optionally, change the filter control values on the second page and see how they
synchronize with the ones on the first page.

Bookmarking Control Selections in a Page

Bookmarking allows users to save filter control selections and other run-time content
customizations that they make in a page so that they can easily reapply them when they run
the page again later. This is especially useful when there are many filter controls on a page
that a user may want to apply each time they access it. Bookmarks are personal to each user
and can easily be created and deleted as needed.
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Bookmarking is enabled automatically once the page has been saved, and is available in
authored pages created with new content and in assembled pages built from existing content.
To add a bookmark, make some filter selections when running a page, and then click the

Bookmarks button , which appears on the page toolbar at run time. You are prompted to
type a name for the bookmark. Click OK to apply it. A maximum of 46 characters display for
each bookmark name. Once applied, the bookmark is added to the list, which you can open by
clicking the drop-down menu arrow next to the Bookmarks button. Select a bookmark from the
list to refresh the page and apply the associated set of filter values. The bookmark list also
includes the Original page option, which reloads the page with the default filter values
selected. From the bookmark list, you can also use the menu for each existing bookmark to
rename or delete the bookmark, or make it your personal default set of filter values when you
load the page, as shown in the following image.

Each user can create a maximum of ten personal bookmarks for a page. If you reach this limit
on a page, delete an existing bookmark to add a new one. The Original page bookmark is
always available and cannot be deleted.
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Bookmarks also save certain user customizations made in the page. For example, if you use
on-chart filtering in an authored page at run-time to create a new filter, you can create a
bookmark to save it. In authored pages, you can also change the filter condition from included
values to excluded values and change the aggregation operation, and in assembled pages, you
can change the content that displays in unlocked containers. All of these changes are saved
when you create a new bookmark.

Setting Dynamic Default Values for Filter Controls

When assembling pages from external content, you can personalize default values for filters in
a page based on users or conditions. This feature uses an amper-amper (&&) global variable to
specify the default option for a filter control. You can then use variables, functions, and
conditions to set the values of these global variables. For example, you can set the Region
value for a user, using the && global variable, and link it to the filter control to show their
region as the selected value, or you can base the default values for a calendar control on the
current date so that they always show a relevant, relative date range.

Procedure: How to Personalize Default Values for Filter Controls

You can use global variables to dynamically set the default values of filter controls based on
the user who is running the page.

1. Start by creating a FOCEXEC which specifies the global variable and the default values. In
this example, we are setting default values for different users for the Region control.

a. On the default Db2 Web Query Hub or Home Page, in the Workspaces area, on the
Action bar, click the Other tab, and then click Text Editor.

The New Text Resource dialog box opens

b. In the New Text Resource dialog box, click FOCEXEC (fex).

The Db2 Web Query Editor opens.

c. Add the following FOCEXEC code to set the global variable:

- &&DEFREGION
-SET &&DEFREGION= IF &FOCSECUSER EQ user1 THEN 'North America' ELSE
-IF &FOCSECUSER EQ user2  THEN 'EMEA' ELSE  'South America'

d. Save your changes and close the Text Editor.

e. Publish the FOCEXEC.

2. Bring the global variable in effect by either running the FOCEXEC or mapping its path in the
Administration Console for it to be run when the user signs in.
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To map the FOCEXEC you just created in the Administration console, add the FOCEXEC
path to the Paths to be executed on user Sign-in field in the Other section under Application
Settings. The FOCEXEC path name can be copied from the Properties panel in the Hub or
Home Page.

Note: If you are setting the FOCEXEC to be executed on sign in, make sure that the Db2
Web Query user credentials are passed to the server. One way to do that is to set the
server connection to Trusted and select the Pass Db2 Web Query User ID and other Groups
radio button. For more information on how to use Administration Console, see the Db2
Web Query Security and Administration technical content.

3. Assemble a page from existing content, as described in Create a Visualization With Existing
Content in Db2 Web Query Designer.

4. Populate your new page with the content that features the Region parameter and add the
Region filter to the canvas using the Filters tab on the sidebar, as described in Applying
Prompted Filters From External Content on page 28.

5. Click the Region filter, open the Properties panel and, in the Settings tab, under Data
Settings, type the default value variable that you created in the FOCEXEC (in this case,
&&DEFREGION).

The following image shows an example of the Default value property populated with the
variable.
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6. Save, publish, and run your page.

The default value for the Region filter control is North America, as shown in the following
image.

7. Sign in to Db2 Web Query as one of the users mentioned in the FOCEXEC.

8. Run the same page.
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The following image shows an example of the user with the username user1 running the
page. The default Region value now is EMEA.

Procedure: How to Set a Dynamic Default Range for a Calendar Control

A calendar control in a page assembled from existing content is a combined control that allows
you to filter for a date range by selecting a start date and an end date. You can use date
functions to set global variables for the start and end date to a fixed length of time from the
current date, then use those global variables as the default start and end date values for a
calendar control.

The calendar control default dates must be entered using the full month name, for example,
December 31 2019.

1. Start by creating a FOCEXEC procedure that specifies global variables for the default start
and end dates. In this example, we will make the default start date a week before today,
and the end date today.

a. On the Db2 Web Query Hub or the Db2 Web Query Home Page, in the Workspaces
area, on the Action bar, click the Other tab, and then click Text Editor.

The New Text Resource dialog box opens.
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b. In the New Text Resource dialog box, click FOCEXEC (fex).

The Db2 Web Query Editor opens.

c. Add the following FOCEXEC code to set the global variable:

-SET &LASTWEEK = AYMD(&YYMD, -7, 'YYMD');
-SET &&FROM_DATE = CHGDAT('YYMD', 'MDYYX', &LASTWEEK, 'A17');
-SET &&TO_DATE = CHGDAT('YYMD', 'MDYYX', &YYMD, 'A17');
-DONE

Three variables are defined in this FOCEXEC: &LASTWEEK, &&FROM_DATE, and
&&TO_DATE. &LASTWEEK is a variable that provides the date from one week ago. It
does need to be used directly in the calendar control, so it is not created as a global
variable. &&FROM_DATE and &&TO_DATE need to be saved for use as default values
in the calendar control in our page, so they are created as global variables.

&LASTWEEK is created using the AYMD function, which takes a date, a number of
days to add to that date, and a date format. In this case, we are using &YYMD, which
is a system variable that provides the current date in YYMD (year-month-day) format.
We are subtracting one week (seven days) from the current date. The date format is
YYMD.

The date format needs to use the full month name, and must be in month-day-year
order. We will use the CHGDAT function to convert the date to the proper format for
both the &&FROM_DATE and the &&TO_DATE global variables. The CHGDAT function
uses four parameters: the format of the input date, the order of the output date, the
input date value, and the output date string format as an alphanumeric field.

The format of our two input dates, the date of one week ago set by the AYMD function
and the current date, are both in YYMD format, so that is the first argument of both
CHGDAT functions. Similarly, the output of both functions is MDYYX, which generates
a date with the full month name in month-day-year order. Typically, the format for such
a date would be MtrDYY, but since the CHGDAT function uses date character strings
instead of actual date values, it has its own date format designations. MDYY sets the
date order as month-day-year, with the year written in four digits, and the X indicates
that the full month name should be displayed.

The third argument of the CHGDAT function is the date to be converted. For the
&&FROM_DATE variable, it is &LASTWEEK, which was previously defined in this
FOCEXEC using the AYMD function. For the &&TO_DATE variable, it is &YYMD, a
system variable representing the current date in YYMD format.

Finally, A17 defines the string length of the converted date. 17 characters is long
enough to fit any date string.
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For more information about the AYMD and CHGDAT functions, see the Using Functions
technical content.

d. Save your changes and close the Text Editor.

The FOCEXEC must be available to any users for whom you want to set default values
in the page. Save it in a location where it will be accessible and then publish the
FOCEXEC, or share it with any users after saving.

2. Bring the global variable into effect by either running the FOCEXEC or mapping its path in
the Administration Console for it to be run when the user signs in.

To map the FOCEXEC you just created in the Administration console, add the focexec path
to the Paths to be executed on user Sign-in field in the Other section under Application
Settings. The FOCEXEC path name can be copied from the Properties panel on the Hub or
Home Page.

3. Assemble a page from existing content, as described in Create a Visualization With Existing
Content in Db2 Web Query Designer.

4. Populate your new page with the content that is filtered for a date range, and add the
calendar control to the page using the Filters tab on the sidebar, as described in Applying
Prompted Filters From External Content on page 28.

5. Select the calendar control, open the Properties panel and, in the Settings tab, under Data
Settings, type the default value variables that you created in the FOCEXEC (in this case,
&&FROM_DATE for the first value and &&TO_DATE for the second value).
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The following image shows an example of the Default value property populated with the
variable.

6. Save and run your page.
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The default date range in the calendar control is automatically set to the past week. The
dates will update every day to always represent a period of one week.

Adding Headers and Footers to Content

You can use headers and footers to add key information, such as the purpose of your chart or
report and the audience for whom it is intended.

You can add multiple lines of information into the heading and footing areas, and apply
different styling options to different sections of the heading or footing. This accommodates
thorough explanations and additional information, while offering the most readable
presentation.

When you create a chart or report, the heading area is available above your content, and the
report footer is available below your content. You can click within these areas to edit them. To
show or hide these areas, on the Settings tab, expand the Content section, then select the
Enable heading or Enable footing check boxes.
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When you double-click the Page Heading or Page Footing placeholder text in the canvas, the
heading or footing is selected for editing and the styling toolbar appears.

You can make styling changes to the text in your headers and footers, according to your
preferences. Using a WYSIWYG canvas, formatting changes are applied instantly, allowing you
to see the results of your styling selections as you make them. When editing your header or
footer, you can find the options at the top of the canvas, as shown in the following image.

You can change the font and font size using the drop-down lists. You can add bold, italic, and
underline accents to your text. In addition, you can change the positioning of your text (left,
center, and right). You can also customize the color of the text, as well as the background of
the header or footer text area. When your formatting is complete, you can close the toolbar
and continue working with your report. The canvas adjusts to ensure that all lines of the
heading or footing are visible.
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You can add a new line in the heading and footing by pressing the Enter key. The number of
lines of heading and footing you can add to a report is only limited by the available space on
your screen. A scrollbar is added to a report if all of the data cannot fit on the canvas or in the
container.

When you are done editing the heading or footing, click the X button on the styling toolbar to
close it. Once you have edited the header or footer, the updated text will appear when the
report is run.

If you delete the header or footer text and then close the styling toolbar, the header or footer is
removed from the report. You can select the header or footer area and enter text to add them
to the report again.

Heading and footing text in Db2 Web Query Designer is created at the page level, so the
heading or footing is displayed for each separate page of a chart or report. You can create
separate pages in a chart by adding a field to the Multipage bucket, or in a report by right-
clicking a field in the Rows bucket, pointing to Insert breaks, and selecting Continuous
numbering or Restart at 1.

You can add dynamic heading or footing text by dragging a field from the Fields tab into the
heading or footing text area, or by typing a less-than sign (<) followed by the field name. At run
time, the first value for the selected field is displayed in place of the field name in the header
or footer. You can combine dynamic page heading or page footing text with filters or page
breaks to provide more relevant information at run time.

Procedure: How to Add a Dynamic Page Heading to a Report

You can add a dynamic page heading to a report that changes depending on filter selections
and sort values for each page.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Content picker, select a report format, such as the standard report or grid report
layout.

4. With the Fields tab selected on the sidebar, In the Dimensions area of the Resources
panel, expand Product, and add the Product Category and Product Subcategory fields to the
Rows bucket, in that order.
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5. In the Measures area of the Resources panel, expand Sales, and drag Quantity Sold and
Revenue to the Summaries bucket.

6. Create a filter for Customer Country.

In the Dimensions pane, expand Customer and drag Customer Country into the Filter
toolbar.

7. Select Argentina, and click outside of the filter control to apply the filter.

8. Create a page break after each Product Category value.

Right-click the Product Category field in the Rows bucket, point to Insert Breaks, and click
Continuous numbering.

9. Double-click the Page Heading text above the report to select it for editing.

10. Delete the placeholder text in the heading area, and type Sales for.

11. From the Dimensions pane, drag the Product Category field into the heading area after
where you typed Sales for.

The heading should resemble the following image. Dynamic values for the Product
Category field will be substituted for the text string starting with the less-than sign (<) at
run time.

12. Click the close button on the styling toolbar to finish editing.

13. On the Properties panel, on the Settings tab, expand the Settings area and select Enable
footing.
The page footing placeholder text appears at the bottom of the page.

14. Double-click the page footing area to select it for editing.

15. Type, This report shows figures for sales in.

16. From the Dimensions pane, drag the Customer Country field into the footing area after the
text that you just typed.

The name of the field, with a less-than sign in front of it, appears in the page footing area.

17. With the entire page footing text selected, click the Italic button on the styling toolbar.

18. Click Run in new window to see a run-time view of the report.

Notice that the page header appears and displays a different value for each Product
Category value. The Page footer appears below each section of the report, and indicates
that values are for Argentina, since this was the value selected for the Customer Country
filter. If you were to select a different value for Customer Country, the footing text would
automatically change.
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The following image shows an example of what a section of the report may look like.
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Setting Conditional Styling Based on Data Values

Conditional styling is a feature that applies unique styling to cells in a chart or report when
their values meet specified criteria. This allows you to highlight values that are especially high
or low, or are higher and lower than those in another field, making it easy to spot important
information in your content. You can even use conditional styling to add drill down links to
values that match your set criteria, allowing users who run the chart or report to access
additional context and information pertaining to those records. The following image shows a
report to which conditional styling has been applied. Revenue values higher than 5,000,000
have a bright green background, while revenue values lower than 500,000 have a bright pink
background.
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Conditional styling is set on the field level. To enable conditional styling for a field, right-click
the field that you want to style in its bucket, and then click Conditional Styling. The Conditional
Styling panel opens, where you can set the criteria that, when met, will trigger conditional
styling. By default, the field to which the conditional styling will be applied is the field whose
values the conditional styling criteria are evaluated against. You can change the field used in
the criteria, however, allowing you, for example, to style values in a sort field based on the
measure values associated with them.

You can set the operator and the field or static value to which the values of the selected field
will be compared. For example, you can choose to apply conditional styling to values in a field
that exceed a specified value, or that are greater than the value in the same row of another
specified field. For example, you may wish to highlight sales where the cost of goods was
greater than the revenue, indicating a net loss. If you choose to compare field values to
another field, you can select one from a list of measure or dimension fields in the chart or
report. The list of fields is filtered based on the type of field to which the comparison is being
made. To compare field values to a static value, type that value into the text box.

You can create a conditional styling criterion using the following comparative operators:

Equal to

Not equal to

Greater than

Less than

Greater than or equal to

Less than or equal to
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Once you have set your criteria for conditional styling, you can apply a variety of styling
properties to be used when the criteria are met. For a chart, you can set the color of risers that
meet the conditional styling criteria. For a report, you can set the font, text size, text color, font
style, justification, and background color of conditionally styled cells. The styling options for a
report are shown in the following image.

In addition to standard report cell styling options, you can also create drilldowns as part of your
conditional styling, which allow users who run the report to drill from values that match the
conditional styling criteria to content or external resources with additional information. Values
that do not meet the criteria do not have drilldowns applied. For more information about
drilldowns, see Adding Drill-Down Links to Content on page 149.
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Multiple conditional styling criteria can be added to each field. They are listed as separate
conditions above the conditional styling options. If multiple conditions are available, you can
click the name of the condition to edit it. Click the trash can icon next to a condition name to
delete it. You can also use the handles next to the name of the condition to reorder your
styling conditions, allowing you to specify the order in which the conditions should be tested
against each record in the selected column. This can be especially useful if you have
conditions that overlap. For example, if you have a condition to set the background of cells
with values greater than 250 to yellow, and a second condition to set the background of cells
with values greater than 500 to bright green, then as a best practice, place the condition with
the higher threshold first, so that only values above 500 are initially styled, before the
remaining values are styled based on subsequent criteria, as shown in the following image.
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Once you have set the conditions and the styling that you want to apply when those conditions
are met, click Apply. You can then close the Conditional Styling panel. When you run the report,
the values in the styled field that match your specified conditions have special styling applied,
making them easy to identify at a glance.

Changing a Field Format

Changing the display or output format of fields that have been placed on the canvas or in field
containers allows you to control how values in a field are interpreted and the styling that they
use when displayed. This feature allows for field display formatting, which is essential for any
data-based content design tool.

In a report, the field format is reflected in the format of data values. In a chart, the field format
may be reflected in data values in the chart, if they are displayed, or in the tooltip. Note that
series based data labels in a chart are formatted independently from the field itself.

Note: These formatting options are applied when the Db2 Web Query Reporting Server
retrieves data from the data source. When that data is passed to the JavaScript chart engine
to generate a chart, some formatting information may not be included and replaced with
default settings. For reports, the selected field formatting options are passed directly.

When you change the field format, a new calculated field is created with the new format,
replacing the original field. The calculated field is also added to the field list. The new field is
identified by the number 1 appended to the field name and title. Additional format changes can
be applied directly to the new, reformatted field, without creating additional calculated fields.
The original field is still available in the field list if you want to restore the original format
without using the field format options.
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To change the format of a field in a bucket on the Properties panel, right-click the field and
point to Format data, as shown in the following image.

Note: When editing the format of a field, the only options available are those that are relevant
to the selected field.
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When creating or editing a calculated field, you can access Data Format options by clicking the
Edit Format button, which appears with a different icon depending on whether the field is a

number , character , or date field , and which is located above the Operator Selection
pane next to the field name, as shown in the following image.
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To edit the format of a field, first select the data type, then set details specific to that data
type. In the following image, the numeric data type is selected, providing options for numeric
fields.

You can select one of the following data types:

Character format, for fields containing letters and numbers.

Number format, for fields containing numbers that you want to sum or aggregate.

Date format, for fields containing dates.

Other format, for fields that have values that do not match one of the other formats, such
as date-time fields or string fields, or are a variety of another type of field, such as packed
decimal fields or Julian date fields.
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When you select the character data type, you can specify character-specific formatting, as
shown in the following image.

You can use the Length option to select the number of characters to display in the field, and
enable variable length. Variable length indicates that the number of characters can vary
depending on the data that is stored in the field.

When you select the numeric data type, you can specify number-specific formatting, as shown
in the following image.
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You can choose whether or not to display decimals, and set the maximum number of digits to
show before and after the decimal point. You can also choose how to format negative
numbers, whether to show thousands separators, and whether to show a zero before the
decimal point when the value is less than one.

You can also specify currency and percent variations, such as a different currency symbol or a
change in the use of a percentage value. When you select the currency option under Type, the
Currency symbol and Symbol position options appear, allowing you to select the currency
symbol and how it displays. When changing the format of a numeric field, a preview shows an
example of what data values may look like based on the current field format settings.

Note: The Percent data format option automatically multiplies the field value by 100 so that
decimal values are accurately converted to percentages. If your data values do not need to be
multiplied by 100 and only need the percent symbol (%) added, select the custom format data
type and manually enter a field format followed by %. For example, D12.2%.

When your data type is a date field, you can make a selection from the supported date formats
that are available for selection. The options for a date field are shown in the following image.

The Date format menu shows a list of date formats as applied to December 31 of the current
year. You can select date formats that use separators or month names, or show a single date
component.

When you select a date format that uses a separator, the Date separator menu is available.
You can choose to use a slash (/), dash (-), dot (.), or space.
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If you want to use a format not available in the character, number, or date sections, you can
select the Other data type. Type a valid Db2 Web Query field format into the Format text box.
For example, the following image shows a field using the format HMDYYS, which is a date-time
format.

The Other data type, like all of the other data types, does not allow field transformations,
which prevents invalid formats. If the field was originally alphanumeric, you can enter a custom
alphanumeric format. If the field was originally numeric, you can enter a custom numeric
format. If the field was a originally a date field, you can enter a custom date format.

Procedure: How to Change the Number of Decimal Places in a Field

You can change the number of decimal places that display for a numeric field to show fewer or
more decimal values. Showing more decimal values allows you to analyze your data with
greater precision, while showing fewer decimal values may help make information more
immediately digestible.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace with access to the wf_retail sample data, and select wf_retail_lite.mas
as the data source.

Db2 Web Query Designer loads with options to create a single content item.

3. Change the content type to a report. In the Content picker, select one of the report
layouts.

Using a report makes it easy to see all data values directly on the canvas. If you are
creating a chart, you can see exact data values when you point to a section of the chart to
display a tooltip.
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4. Add a sort field, for example, Product Category, to the Row bucket and a measure field, for
example, Revenue Per Sq. Ft., to the Measure bucket.

5. Change the format of the measure field to show four digits after the decimal point, by
doing the following:

a. In the Measure bucket, right-click a field and point to Format data, as shown in the
following image.
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b. If the field is not already in a numeric format, change the data type to numeric by
clicking the number button in the Data type section, as shown in the following image.

c. To display decimals, ensure that the integer option is not selected in the Type section.
You can select the decimal, currency, or percent option depending on how you want
the field to display.

d. To change the number of digits after the decimal, use the arrow control to increase or
decrease the Decimal place value, or type a number in the text box.

e. Check the data preview in the Sample data text box. If it shows the symbols and the
number of values that you want to display in your content, click OK to accept your
format changes.

The field whose format you modified is replaced with a new version that shows the specified
number of decimal points, as shown in the following image.
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The field whose format you modified now shows the specified number of decimal points, as
shown in the following image.

Creating Calculations

When you create content, you are not restricted to the fields that exist directly in your data
source. You can add calculations to automate summations and other mathematical tasks
related to your data fields. You can specify operators, fields, variables, and functions when
creating a calculation. If you can generate the information you want from the existing data, you
can create a temporary field to evaluate and display it. A temporary field is a field whose value
is not stored in the data source, but can be calculated from the data that is there. A temporary
field takes up no storage space in the data source, and is created only when needed.
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You can create two types of temporary fields, which differ in how they are evaluated:

A pre-aggregation calculated field, or DEFINE, is evaluated as each record that meets the
selection criteria is retrieved from the data source. The result of the expression is treated
as though it were a real field stored in the data source.

A post-aggregation calculated field, or COMPUTE, is evaluated after all the data that meets
the selection criteria is retrieved, sorted, and summed. Therefore, the calculation is
performed using the aggregated values of the fields.

Performing Basic Calculations

You can use the calculator to perform basic calculations on fields in your data hierarchy. When
you create a calculated field, a new, unique field is created. It incorporates all of the data
fields and expressions that you added to the calculation.

Once the calculation is complete, a new data field is created which can subsequently be used
in your content. This field is placed on the Data pane, using the label of the originating field on
which you created the initial calculation. For example, you can perform an addition operation
on two fields. This action sums the values of the fields, displaying the total of the two when
the field is used in a chart. You can also perform more advanced calculations that can result in
different outcomes.

Calculated fields include DEFINEs, COMPUTEs, quick transforms, and more. You also have
access to Db2 Web Query functions that can be used in a calculation to perform specific

operations on character and numeric fields. These display in a list of available functions .
They are separated into categories, listed in alphabetical order, and are case-insensitive.

A DEFINE field is evaluated before data aggregation, while a COMPUTE field is evaluated after
data aggregation. This means that DEFINE fields are especially useful to sort the data in a
chart or report, while a COMPUTE field is especially useful as a measure field.

You can determine whether a calculation will be created as a DEFINE or COMPUTE by selecting
Calculate at the source or Calculate after aggregation in the calculator. When you select
Calculate at the source, a DEFINE field is created, and when you select Calculate after
aggregation, a COMPUTE field is created. When you create a DEFINE field, it is added to the
field list, from where you can add it to your content. When you create a COMPUTE field, it is
added to your content automatically, in the default measure bucket if it was created from the
field list, or in the bucket from where you created the COMPUTE.
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Access the calculation feature in one of the following ways:

Right-click a field in the Resources panel and click Add calculation. This creates a DEFINE,
by default, with the selected field added automatically to the calculation. If you create a
DEFINE, it is added to the Resources panel, from where you can add it to your content. If
you create a COMPUTE, it is added to the default measure bucket.

Right-click a measure field in a bucket and click Add calculation. This creates a COMPUTE,
with the selected field automatically added to the calculation. The calculated field is added
to the bucket from where you accessed the calculator.

Click the menu in the Dimensions area or Measures area of the Resources panel, and click
Add calculation. This creates a DEFINE, by default. If you create a DEFINE, it is added to the
Resources panel, from where you can add it to your content. If you create a COMPUTE, it is
added to the default measure bucket.

When creating a report, click the menu for the Rows bucket or the Summaries, Counts,
Details, or Details with counter bucket, and click Add calculation. This creates a COMPUTE.
The calculated field is added to the bucket from where you accessed the calculator.

Right-click a calculated field that you created previously and click Edit calculation. This
allows you to modify an existing calculated field. This option is available from the field list
for DEFINE fields, and from a bucket in the Properties panel to which a calculated field has
been added.
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When you perform one of these actions, the calculator opens, as shown in the following image.
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The numbering in this image points out the different areas of the interface, as a guide.

1. Title bar. Shows context information about the current calculation. For example, New
Calculation or Edit Calculation, along with the field name.

2. Evaluation options. Determines the type of calculation. Select Calculate at the source to
create a pre-aggregation, DEFINE field, or select Calculate after aggregation to create a
post-aggregation, COMPUTE field.

3. Close button. Closes the Calculator. Clicking this button performs the same function as the
Cancel button.

4. List chooser. Allows you to select which list should be displayed in the Calculator. For
example, functions.

5. Search box. Allows you to search for components across all subjects (Fields, Functions,
and Variables). The search will find matches on contiguous text and performs a case-
insensitive search. A flat list of matches is returned.

For Fields, matches are performed on Name, Title, and Positional (folder or segment)
information in the hierarchy.

For Functions, matches are performed on Name, Category, Parameters, and Help text.

For Variables, matches are performed on Name.

6. Field/Function/Variable list. Lists the fields, functions, or variables that are available for
selection and on which you can perform a calculation.

The following considerations apply to Field/Function/Variable lists.

A Field list will always present with Single-list mode. It operates the same way as the
Field List tab in the Field Tree.

The Function list displays a categorized list of Db2 Web Query functions, sorted case-
insensitive in alpha order (ascending or descending). You can use the drop-down menu
to select the category of the function that you want to use, or you can search for a
function. Double-click or drag and drop a function into the Canvas and then supply
parameter values to use it.

You can still use a function, even if it is not listed, by typing it into the calculator
canvas. See the Using Functions technical content for a complete list of available
functions, including legacy functions.
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A Variable list displays a list of system variables in Db2 Web Query. The Variable list tab
operates the same way as the Variable list tab in the Field Tree.

7. Calculated field definition area. Displays the field name for which an expression is being
created. It displays an icon (separate) to allow its format to be set with the Data Format
Selector.

Format icon. You can use the Format icon to change the target field format for the
calculation.

Properties icon. Enables you to change the target field properties for the calculation,
such as the field name and title, and whether to allow missing values.

8. Operator Selection pane. This pane displays a full, contextualized list of operators that are
available in calculations. It also displays mathematical and logical operators. Additional
statements (IF, THEN, ELSE) are also included.

9. Canvas/typing surface. This is where you build your calculation. It shows fields,
aggregations, and other items related to the calculation you are creating. It also supports
functions, variables, operators, values, and placeholders.

10.Function Help. When working with Functions, you may receive help messages, such as a
description of the selected function and the values that you must supply.

11.Actions. Includes a Validate button that allows you to check whether the syntax that you
have provided for the DEFINE or COMPUTE is structured correctly, and options to cancel or
commit the calculated field.

Procedure: How to Create a DEFINE Field Using a Db2 Web Query Function

A DEFINE is a virtual field that is evaluated as each record that meets the selection criteria is
retrieved from the data source. The result of the expression is treated as though it were a real
field stored in the data source. It is added to the field list in the Resources panel, from which
you can add it to multiple content items.

You can use a Db2 Web Query function in a DEFINE or in a COMPUTE to transform data from
an existing field to create a new field. Each function accepts a different set of arguments that
are added in parentheses after the function name.

DEFINEs are built from the field list in the Resources panel.

DEFINEs can be created in the following ways:

In a Master File. These virtual fields are available whenever the data source is used.

In a procedure. A virtual field that is created in a procedure lasts only for that procedure.
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In this example, a new DEFINE field will be created that uses the DTRUNC function to supply
the first day of the week for each sale date.

1. Create a new visualization in Db2 Web Query Designer, using wf_retail_lite.mas as the
data source.

2. With the Fields tab selected from the sidebar, in the Resources panel, right-click a field or
click the menu next to the Dimensions area or Measures area, and then click Add
calculation.

The calculator opens to create a new DEFINE field, by default. Notice that the Create at the
source radio button is selected.

3. In the Calculator dialog box, click the Functions tab .

The Function list appears, and displays the first available function category.

Note: If you create the new calculation by right-clicking a field, that field is automatically
added to the calculator text area. For the present example, delete this text before
continuing.

4. Navigate to the DTRUNC function using one of the following methods:

In the search box, type DTRUNC.

Expand the function category drop-down menu, and select Date/Date-Time.

Double-click the DTRUNC function, or drag it into the Calculator text area.

The text area displays the function and identifies the required arguments, in this case,
date and period. Notice that an example is provided in the space below the calculator text
area.

5. In the text area, inside the parentheses after DTRUNC, select the word date.

6. In this space, specify the input date that will be used to provide the first day of the week.
In this case, instead of a single date, provide an entire date field, so that the DEFINE field
will generate a value for each input date value.

Click the Fields tab  to access the Field list. Under Dimensions, expand Sales_Related,
Transaction Date, Simple, Sale,Day, and Sale Date Details, then double-click Sale,Date.

The Sale Date field is added as the first argument in the DTRUNC function, as shown in
the following image.
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7. Replace the word period with the date component that you want the field to use as
increments. In this case, it is the first day of each week. Type WEEK as the second
argument in the DTRUNC function, in place of the period placeholder text. The completed
function should resemble the following:

DTRUNC("Sale,Date", WEEK)

8. Since the output of the DTRUNC function is a date field, the DEFINE field should use a
date format.

Click the Edit format button, change the Date type to a date format, and select an option
of your choice from the Date format drop-down menu.

Click OK.

9. Optionally, double-click the name of the DEFINE field to change it.

10. Click Validate to confirm that the DEFINE is set up correctly.

11. Click OK to return to the calculator.

If the validation indicated that there was an error, determine the cause of the issue and fix
it.

12. Click OK to finish creating the DEFINE field.

If you created the DEFINE by right-clicking a field in the Field panel, it displays at the
bottom of the measure or dimension group where it was created from. If you have trouble
locating your calculated field, type the name into the search box to find it.

13. Add the DEFINE to your content as a sort field.
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You can use the calculated field from this example to create a chart or report that shows
sales information for each week, as shown in the following image.

Procedure: How to Create a COMPUTE Field

COMPUTEs are calculated fields whose values are evaluated after all of the data that meets
the selection criteria is retrieved, sorted, and summed. The calculation uses the aggregated
(total) values of the fields. For example, based on the values of Revenue and MSRP fields in
your data source, you could calculate the discount percentage.

Create a COMPUTE field by selecting Calculate after aggregation in the calculator.

1. Create a new visualization in Db2 Web Query Designer, using wf_retail_lite.mas as the
data source.

2. With the Fields tab selected on the sidebar, on the Resources panel, in the Measures
area, expand the Sales folder, and double-click the Revenue field to add it to a measure
bucket.

3. From the measure bucket, right-click the Revenue field and click Add calculation.

4. In the Calculator dialog box, build the COMPUTE.
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Note: The field that you right-click to create the COMPUTE field is automatically added to
the text area, as shown in the following image.

You can select another field, or add fields from the data source tree that display.

Note: For COMPUTEs, the Calculate after aggregation check box is selected, indicating
that the field values are evaluated after the chart or report has been sorted.

5. Type the mathematical expression to create a COMPUTE field to evaluate the discount
percentage using the Revenue and MSRP fields:

a. Click to place your cursor before the Revenue field in the text area, and type 1 - (.

b. Click to place your cursor after the Revenue field, and type /.

c. From the data tree, under Measure Groups, expand the Sales folder and double-click
the MSRP field to add it to the expression.

d. Type ) to close the expression. The completed expression for the COMPUTE field
should resemble the following:

1 - ("Revenue"/"MSRP")
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The following image shows this expression in the Calculator.

Note: You can use the buttons in the Operator Selection area instead of typing some
mathematical operators.

6. To show the discount percentage as percentage values instead of as a decimal, change
the format of the calculation.
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Click the Format icon to open the Format dialog box. Click the Percent Type option to
change the field format to a percentage, as shown in the following image.

The percentage option automatically multiplies the values in the field by 100 to produce a
percentage, so we do not need to perform this operation in the COMPUTE expression.

7. Click OK to accept the field format change.

8. Optionally, change the name of the COMPUTE field. It is assigned a default name based
on where the COMPUTE field was created from. Unless you specify a different column title,
this name appears in the bucket where the COMPUTE is used and in your content.

Double-click the field name next to the Format icon, and type a new name for the field.

9. Optionally, change the column title that displays for the COMPUTE field when it appears in
your content.
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Click the Field Properties menu, and type a column title for the field, as shown in the
following image.

10. Click OK to accept the new column title for the COMPUTE.

11. Click Validate to confirm that the COMPUTE is set up correctly.

12. Click OK to return to the calculator.

If the validation indicated that there was an error, determine the cause of the issue and fix
it.

13. Click OK to finish creating the new COMPUTE field.

The field is added to the same bucket from which you created it. You can move it to a
different bucket or delete the original field, Revenue, in this example, from which it was
created.
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The following image shows a data grid that displays the Revenue and the calculated
Discount Percentage for different product models.

If you remove the COMPUTE field from your content, it is deleted permanently. COMPUTE fields
are not stored in the Resources panel.

Procedure: How to Edit an Existing Calculation

Once you have created a calculated field (DEFINE or COMPUTE), you can edit it. This allows you
to revise the calculation and in the field so that you can achieve the results you expect.
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Note: You cannot edit a calculated field that is already being used in a static or prompted
filter. You may, however, delete the filter, edit the calculated field, then recreate the filter using
the edited field.

1. On the Db2 Web Query Hub or Db2 Web Query Home Page, locate a visualization with new
content that uses a calculated field. Right-click it and click Edit.

Db2 Web Query Designer opens.

2. If you created a DEFINE field, the calculated field was added to the Field panel. Right-click
the calculated field and click Edit calculation. If you created a COMPUTE field, or already
added the DEFINE field to your content, you can also edit it from the bucket to which it
was added.

3. Modify the calculated field using the calculator.

4. Click Validate to confirm that the calculated field is set up correctly.

5. If the validation indicated that there was an error, determine the cause of the issue and fix
it.

6. Click OK.

The revised field displays in the location from which you edited it.

Using Prefix Operator Aggregation Functions

You can use prefix operator aggregation functions to instantly apply a number of different
aggregation operations to fields, unlocking significant insight into your data without writing your
own calculations.

To apply a prefix operator, right-click a field in a measure bucket in a chart or report, point to
Aggregate, and select one of the following options:

None. Does not explicitly apply a prefix operator. When the Summaries display option is
selected, the Sum aggregation is used. When the Counts display option is selected, the
Count aggregation is used. When the Details or Details with counter display options are
used, no aggregation is applied.

Sum. Adds record values together for the selected field within each sort value.

Average. Calculates the average of record values for the selected field within each sort
value.

Count. Provides the number of record values for the selected field within each sort value. If
there are no missing values in the data source, the count aggregation returns the same
value for every field.
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Count distinct. Provides the number of distinct record values for the selected field within
each sort value.

Percent. Calculates a percentage for each sort value based on the summed total value for
the selected field.

Percent of count. Calculates a percentage for each sort value based on total record count
for the selected field.

Minimum. Provides the minimum value for the field within each sort value.

Maximum. Provides the maximum value for the field within each sort value.

Median. Provides the median field value with each sort value.

Mode. Provides the most common value of the field within each sort value.

Standard Deviation, Sample. Provides the standard deviation of the field, within each sort
value. Sample standard deviation uses Bessel's correction of n-1 to calculate the standard
deviation.

Standard Deviation, Population. Provides the standard deviation of the field, within each
sort value. Population standard deviation is calculated using n to represent the number of
records in the request.

First value. Available only when a dimension field is added to the measure bucket of a
report. Retrieves the first value in the field from the data source.

Last value. Available only when a dimension field is added to the measure bucket of a
report. Retrieves the last value in the field from the data source.

Distinct. Available only when creating reports with the Details and Details with counter
display options. Displays only distinct values.

Total. Available only when creating reports with the Details and Details with counter display
options. Provides a grand total for the field. The Total operator (TOT.) can also be applied to
a measure field in a header or footer to show the total value.

The operation is instantly applied to the field, indicated by a prefix in the measure bucket.

When you add a dimension field to a measure bucket in a chart, the only available
aggregations are Count, Count distinct, and Percent of count. These options allow you to
understand the distribution of values in dimension fields. When you add a dimension field to a
chart as a measure, the Count aggregation is applied automatically in order to generate
aggregated values for the chart.
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In reports, numeric dimension fields are aggregated by default when added to the Summaries
bucket, while alphanumeric dimension fields have the maximum aggregation prefix applied.
When a dimension field is added to the Counts bucket, the count aggregation is applied. When
a dimension field is added to the measure bucket of a report, the following aggregation options
are available:

Count

Count distinct

Percent of count

Minimum

Maximum

First value

Last value

When using Counts display option, the Count prefix operator is used by default, but other
operators, including Sum, can also be applied. These operators behave the same as when
using the Summaries display option. When using the Details and Details with counter display
options, measure values are not aggregated. As a result, measure fields in the Details and
Details with counter buckets can only use the Distinct, Total, and Percent prefix operators.

You can use the same field multiple times in a chart or report with different prefix operators to
enhance your understanding of your data set. For example, the report in the following image
shows columns for average revenue and median revenue, which helps to understand the
skewness of the data.
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Since the average revenue values for each product category are all greater than the median
revenue values, we can see that the data is skewed to the right. This means there are a higher
proportion of records with lower than average revenue, and that the average revenue is brought
up by some outlying high revenue values.

Similarly, you can use the Count prefix operator in combination with the binning feature to see
the distribution of your data, such as in a histogram. To create a histogram, create a new
chart, right-click a measure field in the Resources panel, point to Bin values, set a bin size and
labeling option, and click OK. The bins appear as a field in the Dimensions area of the
Resources panel. Drag the bin field into the sort bucket of your chart, such as the Horizontal
bucket in a bar chart. Next, drag the same field for which you created your bins from the
Measures area into the bucket used to aggregate measure data in the chart, such as the
Vertical bucket in a bar chart. Finally, right-click that measure field, point to Aggregate, and
click Count. The result is a histogram showing the distribution of values for the selected field,
as shown in the following image.
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Using Dynamic Grouping for Dimension Field Values

Dynamic grouping allows you to create groups of elements based on the field data type that
you select. For example, you may have a field with US state names, but no field for US regions.
Using the dynamic grouping functionality, you can create groups for different regions for use in
a content item without editing the data source. You create one group that combines state
name values like Maine, New Hampshire, and Massachusetts into a New England group,
states such as New York, New Jersey, and Pennsylvania into a Mid-Atlantic group, and so on.
You can even add the extraneous, remaining values into an Other group automatically, if you
do not think they fit into another defined group.

Note: The Create Group option is only available for dimension fields of non-numeric format or
attribute.

You can also specify multiple, unique groupings in the same session. For example, you might
want to group the data to indicate groups or products, or specific regions.

Note: If you want to exclude a specific data element from your analysis, you can use the filter
functionality.

The grouping that you specify is applied and this new group then replaces the original field that
you selected in the Query pane. The name that you specify when creating the group is reflected
in the Query pane.

The process of dynamic grouping creates a Define field, which can then be used in other
reports or charts in the same visualization. When creating a single content item, dynamic
grouping also supports Auto Drill, enabling you to drill through the hierarchy of your data just
like any other data field.

Note: When working with Reporting Objects, Dynamic Grouping is not supported.

Procedure: How to Create a Dynamic Group

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Resources pane, with Fields selected on the sidebar, right-click the data field for
which you want to apply dynamic grouping.

Note: You can use the dynamic grouping functionality on non-numeric dimension fields
only.
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4. Click Group values.

The Create Groups dialog box displays.

5. In the Field text box, optionally type a name for the new group field.

Note: The fully qualified field name is displayed as the Origin Field at the bottom of the
Create Groups dialog box. The display of the fully qualified field name is particularly useful
when renaming or editing a group, as it identifies the data source followed by the
hierarchical location of the field within a data set. For example,
WF_RETAIL_LITE.WF_RETAIL_PRODUCT.BRAND.

6. Create a group of values in one of the following ways:

Use Ctrl + click to select more than one value, as shown in the following image, then
click Group.

Drag one value onto another value. The two values are grouped.

7. Optionally, double-click the group title or select a group and click Rename, and then type a
new name for the group.
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8. Optionally, add more values to the group that you just created using one of the following
methods:

Select one or more values, open the Add to menu, and select a group to add the
values to.

Select one or more values and drag them into a group.

Drag the group onto a single, ungrouped value. The value is added to the group.

If you have multiple groups, drag one group into another group to merge them. The
name of the target group is retained for the merged group.

These methods can also be used to move a value from one group to another group.

9. Optionally, create additional groups using the methods in step 7, as shown in the following
image.

10. Optionally, to ungroup values, click a group and then click Ungroup. Click Ungroup all to
disband all groups.

11. Optionally, click Show other to add all remaining non-grouped values to an Other group.

Note: If you add all values to the Other group, all groups, including the Other group, are
disbanded. You must have at least one group for the Other group to be available.
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12. Click OK.

Your grouped data will display as a new field in the Resources panel. If it is not
immediately visible, you can use the search feature on the field list to find it. From there,
you can add the grouped field to your content, as shown in the following image.

To edit the grouped field, right-click it in the Resource panel and click Edit group values.

Creating Numeric Ranges With Binning

In Db2 Web Query Designer, bins are used to group numeric values by the increment you
specify. This allows you to view large amounts of data across measures or calculated
measures, enabling you to analyze trends and identify outliers. Data binning also allows you
view your data as part of a larger group, displaying ranges of that data in manageable, visible
bins.
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For example, you might want to analyze Cost of Goods Sold against Discount to understand
how discounts impact the cost of goods. First, you add the Discount measure to the Vertical
field container. These values will be used as a guide for the comparative, grouped content in
the bin. If you apply a bin width value of 250 to the Cost of Goods measure, your data values
will be grouped into ranges of 250 (for example, 0 - 250, 250 - 500, 500 - 750). Finally, you
add the new binned dimension field (generated by the bin process) to your chart. Your chart
now displays the binned values against the Discount measure, as shown in the following
image.

As you can see in this example, there is a direct correlation between Cost of Goods and
Discount, with the smaller cost records values (0 - 250) constituting more of the discount
amount. From this example, it is evident that a large portion of total discounts are given for
lower cost items. In this case, binning has given you insight into the frequency distribution of
values in your data.
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Bins are created on a numeric measure field (for example, Gross Profit), as shown in the
following image.

Examples of numeric measure fields include Gross Profit or Discount. Once you create a bin, a
new dimension field is automatically created, allowing you to plot values based on your bin
specifications.

You can create or edit bins using the same options. On the Resources panel, right-click a field
and click Bin values, or right-click a binned field and click Edit bin values. This opens a shortcut
menu with the following options:

Bin width. A standard text box that accepts any number greater than 0.

Show as. Identifies the bin label type.

Value. Displays the alphanumeric representation of the numeric value containing the
minimum value (FLOOR) of each bin. The format should be set to the data format of the
source field.

Range. Displays the alphanumeric string representing the minimum and maximum range
for each bin. The format should be set to the data format of the source field.

OK. Creates a new dimension field based on the bin options that you selected. This
dimension field is automatically added under your dimensions in the Fields tab.

Cancel. Closes the shortcut menu and cancels the changes.
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The following image displays bin values and bin ranges for the DEALER_COST field, using a bin
width of 1000. It also shows how the data falls into the value and range properties.

Note: Bin fields that display ranges, using the Show as Range option, use a character field
format, while bin fields that display floor values, using the Show as Value option, use a
numeric field format. As a result, when displaying ranges, bins with negative numbers display
after bins with positive values. This is due to the sort sequence used for character fields. On
the other hand, when displaying floor values, bins are sorted into numeric order, so negative
value bins display before bins with positive values.
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Therefore, if the measure field that you are binning includes negative values, it is
recommended to select Value as the Show as option. Alternatively, you can display ranges in
numeric order by using a bin with values as a hidden, higher-level sort field and adding the bin
with ranges below it on the same axis. For example, if creating a vertical bar chart, create a
value bin field and a range bin field, both with the same width. Add the value bin field and then
the range bin field to the Horizontal bucket, then hide the value bin field. The ranges are now
in the correct order, as shown in the following image.

Editing an Existing Bin

Once you have created a bin, you can edit it. This gives you the flexibility of changing the size
of the bin or other related parameters. Changes to the bin values appear in real time.

You can edit an existing bin from the Data panel or if you have placed the bin in a bucket, by
right-clicking the bin and selecting Edit bin values.

Note: If a bin field is being used in a calculated field or in a filter, you cannot change the bin
label type.
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Procedure: How to Create a Histogram Using Bins

A histogram is a chart, usually in a bar chart format, that displays the frequency distribution of
values in your data by displaying the count of values in different ranges. The count aggregation
and bins should be applied to the same field to show the frequency distribution effectively.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. If the default content type is not a bar chart, select a vertical bar chart option from the
Content picker.

4. With the Fields tab selected on the sidebar, on the Resources panel, under Measures,
select a numeric measure field and place it in the Vertical bucket. You can also double-
click the field, or right-click it and select Add to chart.

5. Right-click the measure field in the Vertical bucket, point to Aggregate, and click Count.

The prefix CNT. is added to the front of the field name. The vertical axis now represents
the frequency of values of the selected measure field, rather than summed values.

6. On the Resources panel, under Measures, right-click the same measure field and point to
Bin values.

7. Specify a numeric value in the Bin width field. For example, using the numeric value 500
creates bins that group values of 500 together.

Keep in mind the overall range of values in the field that you are binning. Fields with
smaller variance work best with smaller bins, while fields with large variance work best
with larger bins.

8. Optionally, select a Show as option. Range, which is the default, shows the minimum and
maximum value for each range, while Value shows only the minimum value.

9. Click OK to generate the bins for the selected measure field.

Note: The binned measure is added to the Resources panel as a new dimension field that
you can use in your chart.

10. From the list of dimension fields, locate the field that is suffixed by _BIN_1 (for example,
REVENUE_US_BIN_1).
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Note: The binned field is placed under Dimensions on the Resources panel. If you are
viewing these fields using the Folder view, it will be available under a folder with the same
name used under Measures. You can also use the search feature to locate the new
dimension field if needed.

11. Add this new dimension field to the Horizontal field container.

The bins display in your chart. Each bar represents a range of values, and the height of
each bar represents the number of records that fall into each range, as shown in the
following image.

From the image above, we can see that sales falling into the first two bins, up to $500 in
revenue, were the most frequent.
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12. Optionally, to edit the bin width to produce more or fewer bins, or to toggle the bin label
type between ranges and values, right-click the bin field in the Horizontal bucket and point
to Edit bin values. You can then change the bin settings and click OK to apply them.

Enabling Field Selection at Run Time With Field List Parameters

Field list parameters are a powerful tool that allows you to provide users with a selection of
fields that they can use at run-time to build charts and reports within a framework that you
provide. Field list parameters can be added to buckets in place of fields in a chart or report. At
run time, users select the fields that they want to display, giving them the power to choose the
data that is represented by and displayed in your content. You can complement these field list
parameters with fields that always appear in your content, providing a mix of customizable and
static content. Field list parameters can be single select or, if the bucket allows multiple fields,
multi-select, providing even more flexibility. Field list parameters are a key component of
InfoApps, which are pages in which users can select the fields that display.

When you add a field list parameter, it becomes a field container into which you can add one
or more measure and dimension fields. Create a new parameter by clicking Add Parameter
Field List on the Settings tab. The Add Parameter Field List dialog box opens, as shown in the
following image.
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Here, you can supply a prompt name, used as a label for the field list control and bucket,
choose which bucket the field list selections should populate, and determine whether the field
list parameter is single select or multi-select. Multi-select field list parameters are not
available for charts, so when creating a chart, the Control type option is locked to Single select.
When you click Save to create the parameter, a field list parameter placeholder appears in the
location selected from the Bucket Type menu, and a new field list parameter bucket appears
below the Filters bucket. The placeholder is a purple color to distinguish it from regular
measure and dimension fields.
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To add fields to the field list parameter, drag them into the new field list parameter bucket.
Field list parameter buckets only accept the types of fields that can be added to the bucket
that the field list parameter has been added to. For example, if the field list parameter was
created for the Location bucket, only fields with an assigned geographic role can be added to
it. The following image shows the buckets for a report, in which the Product Category, Sale
Year, Sale Quarter, and Customer Business Region fields have been added to a field list
parameter, and the parameter itself has been added to the Rows bucket.
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The order of the fields in each field list parameter bucket is the order in which they will appear
in the field list filter prompt when you run your content. Click the check box icon next to the
field name in the field list parameter bucket to set default values for each field list control. For
field list parameters with a Control type of Multi-select, you can choose to have multiple fields
selected by default. If parameter prompting is set in your environment to run content with
default values without showing autoprompt, then when you run content in which default values
have been set for all field list parameters, you will not be prompted to select fields for your
content.

You can right-click a field in a field list parameter bucket to make some simple modifications to
it. You can rename a measure or dimension field to change the name that it uses in the field
list control when the content is run. The original field name is still used in the content itself
when the field is added to it. You can also right-click a measure field in a field list parameter
bucket and point to Aggregate to change the aggregation of the field. This allows you, for
example, to make both summed revenue and average revenue fields available in the field list.

To edit or delete a field list parameter, click the ellipsis menu on the field list parameter
bucket, and click Edit or Delete. You can also delete a field list parameter by pointing to it in
the standard chart or report bucket to which it was added, and clicking the X that appears
when you point to it. To remove a field from a field list, point to the field in the field list
parameter and click the X, or right-click it and click Remove. To remove all fields from the field
list, click the ellipsis menu for the field list parameter bucket and click Clear.

You can create multiple field list parameters, and add them to buckets together with regular
fields that will always appear in your content, allowing you to have a mix of permanent and
user-selected fields in your charts and reports. Just like regular fields, field list parameters can
be reordered relative to other fields and field list parameters in a bucket, giving you some
control over the sort order of your content, even when user-selected fields are used.
Parameters can be added to any bucket in a report, and in any chart bucket, with the exception
of the Multi-graph bucket.
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When you run a chart or report with field list parameters, you can select the fields with which
each one should be populated using standard filter controls for alphanumeric values. If the
chart or report is run stand-alone, these controls are presented in the autoprompt interface. If
the chart or report is added to an assembled page, you can create filter controls for each field
list parameter to allow users to select fields for each one. The following image shows a page
with controls for multiple field list parameters.

When adding content with multi-select field list parameters to an assembled page, changing
the filter control type to a double list control, or to a check box control with the Allow reordering
option enabled, makes it possible to reorder the selected fields at run time. This provides even
more control over the display of your content when run in a page.

Note: Field list parameters are unavailable in pages created with new content. Charts and
reports with field list parameters cannot be converted into a page. To add content with field list
parameters to a page, create an assembled page using the Assemble Visualizations option on
the plus menu of the Db2 Web Query Home Page.
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Enabling Hierarchical Drilling in Db2 Web Query Designer With Auto Drill

Auto Drill enables you to navigate through different levels within the dimension hierarchy of
your data source. This allows you to review underlying data for a particular area, and move
through the structure of your data source, based on your informational needs.

Auto Drill can be enabled for stand-alone content items. If you convert a chart or report with
Auto Drill to a page with new content, a warning appears, alerting you that Auto Drill
functionality will not be carried over. Auto Drill is functional in content added externally to an
assembled page. To enable Auto Drill, in the Content section of the Settings tab, on the
Properties panel, select AutoDrill. Auto Drill is not available if your chart or report does not
contain fields that are part of a hierarchy.

Once you have enabled Auto Drill, you can develop your report or chart and run it to activate
the hyperlinks that Auto Drill creates. This enables you to navigate up or down through the
related hierarchy of your data source by clicking the links that display.

In a chart, Auto Drill links are available from the tooltip that appears when you point to a
section of a chart, as shown in the following image.
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In a report, Auto Drill links are available when you click a data value hyperlink. The values are
styled as hyperlinks to indicate that you can drill into them, as shown in the following image.

When you click a hyperlink, the option to drill up or drill down displays, depending on where you
are in the hierarchy of your data. You can then select one of these options to begin navigating
your data. For example, if you have Product,Category in your hierarchy, you would be able to
drill down to Product,Subcategory. When you drill down, you can subsequently drill back up to
the originating dimension sort field. If you have selected a data source that has multiple levels
and your report or chart uses a component in the middle of the hierarchy, both the Drill up and
Drill down options will display. Once you have started navigating your data using the Drill up
and Drill down options, the Restore Original option displays, enabling you to start your data
analysis over by re-executing the original Auto Drill request.

The drill up and drill down options are shown in the following image.
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At run-time, the Auto Drill functionality displays a breadcrumb header. This defines your current
location in the hierarchy of your data source and enables you to navigate back and forth
between different levels in your data.

When you drill into a report, the result is filtered based on the selected value, and on the
related values of any higher level sort fields. All applicable values for lower level fields are
shown. Since charts do not have explicit field hierarchies, you can determine how filtering is
applied when using Auto Drill in a chart with multiple dimensions, by selecting different options
from the run-time menu.

When Auto Drill is enabled for a chart with multiple dimension fields, such as if there is one
dimension field in the Horizontal bucket and another in the Color bucket, you can choose
whether to apply filters as part of the Auto Drill navigation, based on the run-time option that
you select. If you choose to apply filters, then when you drill down into a field hierarchy using
Auto Drill, the result drills into the area of the chart that you clicked, and is filtered based on
all dimension field values pertinent to that area. If you choose not to apply filters, the
dimension that you drill into is replaced with the next field in the hierarchy, filtered for the
value of the selected Auto Drill link, and other fields are not filtered. The chart continues to
show all applicable values for other dimension fields.
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For example, the following image shows a stacked bar chart with the Product Category field in
the Horizontal bucket, and the Customer Business Region field in the Color bucket.

When you run the chart and point to a segment of it, the tooltip shows options to use Auto Drill
with or without filters, as shown in the following image.
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When you use Auto Drill to drill into the Product Category field from a segment in the
Accessories riser, and choose not to apply filters, the resulting chart shows subcategories
within Accessories, for all Business Regions, as shown in the following image.
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If you drill into Product Category from a segment in the Accessories riser and do apply filters,
then the resulting chart only shows the Business Region of the segment that you drilled into,
as shown in the following image.

Note:

The Auto Drill functionality is only available for data sources that have a dimension
hierarchy. Dimension hierarchies are a capability of Business View Plus, and also of legacy
Dimension View and Real Cube metadata.

If you have Auto Drill enabled and you attempt to run your chart in deferred mode, the
hyperlinks will not display. This is also true for Auto Drill enabled reports that are
distributed through ReportCaster.

Auto Drill is not supported for all HTML output format charts, or for HTML5 output format
charts that do not support the new chart attributes syntax.

You must use dimension fields as a sorting field, either BY or ACROSS.
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If you are creating a chart that has multiple dimension sort fields in the request and some
of these belong to the same dimension hierarchy, you may encounter multiple links with the
same label in the drill menu.

Auto Drill functionality is not available in reports distributed by ReportCaster, because Auto
Drill uses live data, in an interactive session, for data drilling. Data values and totals may
not be the same if the data has changed since the last distribution. Mixing past data with
current data could impact data analysis.

When Auto Drill is enabled, Accessibility is disabled. When Accessibility is enabled, Auto
Drill is disabled. In Chart mode, Accessibility is disabled, by default.

Procedure: How to Use Auto Drill to Navigate the Hierarchy of Your Data Source

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Create content with one or more hierarchical fields (for example, Product,Category).

4. On the Properties panel, on the Settings tab, expand Content, and then select AutoDrill.

5. Click Run in new window.

Your content displays.

6. If you created a chart, hover over an area of the chart (for example, a bar).
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A menu appears, as shown in the following image.
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If you created a report, click a drill-down link. A menu appears, from which you can choose
to drill up or down depending on your position in the data source, as shown in the
following image.

7. Select a hierarchical value to which to drill down to.

Once you have drilled down on a field, you can subsequently drill up.
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8. To return to the default state of the report or chart, click the Home link in the breadcrumb
trail, or click a hyperlink or hover over a chart aspect and click Restore Original, as shown
in the following image.

Enabling Drill Anywhere to Analyze Field Relationships

Auto Drill is a feature that allows you to drill into values from fields that are part of a data
hierarchy, to see which subcategories within that hierarchy contribute to the values that you
drill into, and to what extent. Drill Anywhere, meanwhile, resembles an enhanced version of
Auto Drill. It does not require the fields in your initial content to be part of a data hierarchy, and
it allows you to drill to any field in your data source, providing a powerful tool to explore
relationships between values in different fields. Instead of drilling from a dimension field to its
children within a pre-defined data hierarchy, with Drill Anywhere, you drill into a sort value to
see which dimension values from the field that you select constitute subsets of that value. The
resulting content is filtered by the value that you drilled into.
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For example, the following image shows a simple bar chart with revenue aggregated by product
category. Drill Anywhere is enabled for the chart, so target fields appear in the tooltip, in the
Drill to menu.

With Drill Anywhere, you can investigate the dimension values that contribute to the value of
the selected riser in a chart, or row of a report. If you point to the riser for the product category
of Computers and click Drill to Customer Country in the tooltip, then the resulting chart shows
information about how much revenue was generated by computer sales in each country, as
shown in the following image.
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To enable Drill Anywhere in your content, on the Settings tab, in the Content Settings area,
click Drill Anywhere. When you run your content, the fields available as drill targets appear in
the tooltips, in the Drill to menu. In reports, you can access these tooltips by clicking a
hyperlink. Hyperlinks for Drill Anywhere in reports are available for all sort fields, allowing you
to substitute a field of your choice for row or column group fields. In charts, you can access
tooltips by pointing to a riser, allowing you to replace the sort field value that it represents.

Note: When using Drill Anywhere in a report using the In-Document Analytic (AHTML) output
format, a limited number of fields are available for selection.

Drill Anywhere is only available for stand-alone content items, when they are run on their own
or when added to a page assembled from external content.

When you use Drill Anywhere to drill to a field from the tooltip, the content refreshes and is
sorted by the selected field. The data in the new content is filtered based on the value from
which you accessed the tooltip. If you continue using Drill Anywhere to drill to other fields, new
filters are applied to the content on top of any filters applied by previous executions of Drill
Anywhere. The applied filter values are indicated by the breadcrumbs that appear above the
chart or report once you have used Drill Anywhere. You can return to a previous drill level or to
the original content using the breadcrumb links. You can also return to the original state of the
content item by selecting Reset from the tooltip in the chart or report.

If your content uses multiple sort fields, you can use Drill Anywhere to drill into each of them.
In a report, you can do this by accessing the tooltip from the sort field that you want to drill
into. In a chart, these fields are listed separately in the tooltip. If you drill into multiple fields, a
separate set of breadcrumbs displays for each, and filters for all values that you drill into, for
all fields, are applied to the Drill Anywhere content. If you drill into a secondary sort field, then
the resulting content is filtered by both the secondary sort value that you drilled into, and the
primary sort value by which it was previously sorted.

Enabling Automatic Content Linking in Db2 Web Query Designer With Auto Linking

Auto Linking makes it easy to connect reports and charts in your development environment,
expanding the reporting capabilities of your organization. Using Auto Linking, you can
dynamically link multiple charts and reports with a single report or chart of any format, based
on their common sort (BY) fields and parameters referenced in any filters. It is this
commonality that dynamically links content in your Db2 Web Query repository, allowing you to
discover new possibilities in your data, and explore new relationships within your reporting
enterprise. In addition, Auto Linking saves development time and effort, because drilldowns do
not need to be manually created and maintained.
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To use Auto Linking, you must use the AutoLink option in Db2 Web Query Designer to set the
reports or charts that provide Auto Linking drilldowns. In addition, you must also set reports or
charts to be Auto Link targets. The options to enable and disable Auto Linking and Auto Link
target functionality are available in the Content area, located beneath the buckets on the Db2
Web Query Designer Properties panel.

Auto Linking and Auto Linking target status can only be enabled for stand-alone content items.
If you convert a chart or report with Auto Linking to a page, a warning appears, alerting you that
Auto Linking functionality will not be carried over.

Note: You can open an existing chart and enable Auto Linking or set the item as an Auto Link
target.

When Auto Link functionality is activated, tooltips in your charts can display links in the tooltip
for each sort (BY) field with qualifying target reports or charts at run time. In Auto Link enabled
charts, you can add sort (BY) fields to the Vertical Axis, Horizontal Axis, or Color field
containers. In Auto Link enabled reports, Auto Linking drill-down links are added to each sort
value for which there are Auto Link targets available.

To qualify a chart as an Auto Link target, you must include filters that contain the parameters
that you selected as the sort field or fields in Auto Linking enabled content. The parameter
names defined in these filters must be the same as the sort (BY) field names in the Auto Link
enabled chart. For example, if you Auto Linking enabled content uses Product Category as a
sort field, then the Auto Linking targets that are available will be those that have parameters
for the Product Category field. When you select a chart as the Auto Link target, it specifies that
the parameter information should be cataloged, and will be evaluated when an Auto Link
enabled chart is run.

For an Auto Link enabled chart or report at run time, the target reports and charts are those
that have filters with parameters for all sort fields. For run time for charts, the linked sort field
values in the Auto Link enabled content is passed to the Auto Link target report or chart and
used as a filter value.

For example, you may have an Auto Link enabled chart that contains sort (BY) fields, Product
Category and Model, with a measure (Sum) field, Revenue. To qualify as an Auto Link target,
other charts in your repository can contain a single filter with a parameter for Product Category,
or two filters with parameters for both Product Category and Model. When you run the Auto
Link enabled chart, the Product Category field will link to target reports or charts that have a
filter with a parameter for Product Category, and the Model field will link to target reports or
charts that have filters for both Product Category and Model.
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You can access the target reports or charts from a tooltip option that displays when you point
your mouse over an area of the chart, such as a bar that represents Revenue by Product
Category and by Model.

Using Optional Parameters With Auto Linking to Enhance Drill-Down Results

In addition to the basic Auto Linking functionality that is available in Db2 Web Query Designer,
you can also add optional parameters to your Auto Link charts, extending the capability of this
feature. An Auto Link enabled chart can link to any target content that you are authorized to
access that satisfies the sort (BY) field to the Auto Link target report filter parameter
requirement. Auto Link target reports that satisfy this requirement and also have optional filter
parameters for other fields are included in the Auto Link target report evaluation, so that all
possible combinations of run-time parameters are evaluated and available as links as you run
the request. This may produce additional reports or charts in your list of available Auto Link
targets, offering you access to an expanded network of related content.

Setting a parameter to optional is not required because the Auto Link enabled content will
pass the value for the fields being filtered to the Auto Link target report or chart. When a sort
(BY) field value in an Auto Link enabled chart is selected, that value and the value of its parent
sort fields are passed to the Auto Link target. When a measure value in a chart is selected, all
sort (BY) field values for that measure are passed to the Auto Link target. If you select the
Optional option, the Auto Link target report or chart can run on its own (from the Resources
Tree or within InfoAssist InfoAssist) without being prompted by Autoprompt for a value for the
parameter. This is because optional parameters are assigned a default value.

With Auto Linking, there is no limit to the number of charts and reports that are available from
an Auto Linking drilldown, and Auto Linking enabled charts can also be an Auto Linking target,
which contributes to the development of a cascading linkage of charts and allows you to drill
through continuously through multiple charts and reports.

Note:

The linked reports and charts displayed are limited to those that you are authorized to run
or run deferred.

The Auto Link enabled and Auto Link target options can be set individually, or both can be
set on the same chart if that item meets the Auto Linking requirements.

Consideration should be given to how many reports or charts are indicated as Auto Link
targets, as the run-time Multi-drill menu for the qualifying target reports or charts may
become long in length. In these cases, some browsers may display a script processing
warning message.
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Auto Linking utilizes the Multi-drill feature with cascading menus, except when running an
HTML report with On-demand Paging enabled or a chart request that is a legacy graph
format (PFJ-based formats, such as PNG and non-bucket HTML5), which will display a
single-level list in the order the drilldowns are specified in the request.

The Multi-drill cascading menu displays:

Horizontal lines to separate user-specified drilldowns and Auto Link navigation options.

Auto Link target reports in a single-level list that is sorted alphabetically, first by folder,
and then the Auto Link target reports and charts within the folder. This may differ from
the sort order of the resource tree that also applies the Properties Sort order option
when sorting folders and items within folders.

When drilling down through a list of Auto Link target reports and charts, a previously
selected Auto Link target report or chart will be excluded so that the available Auto Link
targets are reports and charts that you have not yet viewed.

Procedure: How to Set an Existing Report or Chart as Auto Link Enabled

1. On the Db2 Web Query Hub or the Db2 Web Query Home Page, click the Workspaces tab,
and navigate to a chart or report for which you want to enable Auto Linking.

2. In the content area, right-click the chart that you want to set as Auto Link enabled, and
then click Edit.

Db2 Web Query Designer opens in the relevant mode.

3. Verify that there is a sort (BY) field in the report or chart.

For charts, sort fields are added to the Vertical, Horizontal, or Color buckets.

In a report, sort fields are added to the Rows bucket.

4. On the Properties panel, on the Settings tab, expand Content, and then select AutoLink.

5. Save the report or chart.

Your existing chart or report is now Auto Link enabled.

Procedure: How to Set an Existing Chart as an Auto Link Target

1. On the Db2 Web Query Hub or the Db2 Web Query Home Page, click the Workspaces tab,
and navigate to a chart or report that you want to link to as an Auto Link target.

2. In the content area, right-click the chart that you want to set as an Auto Link target, and
then click Edit.

Db2 Web Query Designer opens in the relevant mode.
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3. On the Properties panel, on the Settings tab, expand Content, and then select AutoLink
target.

Note: Selecting AutoLink target specifies that the parameter information for this chart will
be stored, adding it to the repository of reports and charts that will be evaluated when an
Auto Link enabled report is run.

4. Verify if the report or chart has an existing filter, as qualifying target reports are those that
have filters with parameters for the sort (BY) fields in Auto Link enabled reports or charts.
If a filter does not exist, add a filter prompted filter to the target report or chart.

a. From the Data pane, drag a sort (BY) field onto the Filter toolbar. You do not need to
select a value.

Note: When creating a parameter for a field, the parameter name defaults to the
name of the field that you select. For example, if you create a filter for the Product
Category field by dragging it to the Filter toolbar, the name of the resulting parameter
is &PRODUCT_CATEGORY, reflecting the field name PRODUCT_CATEGORY. You can
see the field name in the tooltip when you point to a field on the Fields pane.

5. Save the chart.

Your existing chart is now set as an Auto Link target.

Procedure: How to Create a New Auto Link Enabled Chart

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Settings tab of the Properties panel, expand the Content area, and then select
AutoLink.

4. Add fields to the report or chart, ensuring that one is a sort (BY) field.

For charts, sort fields are added to the Vertical, Horizontal, or Color field containers
depending on the chart type.

For reports, sort fields are added to the Rows bucket.

5. Save the chart.

Your chart is now set as Auto Link enabled.
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Procedure: How to Create a New Auto Link Target Chart

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Settings tab of the Properties panel, expand the Content area, and then select
AutoLink target.

Note: Selecting AutoLink target specifies that the parameter information for this chart will
be stored, adding it to the repository of reports and charts that will be evaluated when an
Auto Link enabled report is run.

4. Add fields to the chart or report.

5. Add a prompted filter.

From the Data pane, drag a sort (BY) field onto the Filter toolbar.

Note: When creating a parameter for a field, the parameter name defaults to the name of
the field that you select. For example, if you create a filter for the Product Category field by
dragging it to the Filter toolbar, the name of the resulting parameter is
&PRODUCT_CATEGORY, reflecting the field name PRODUCT_CATEGORY. You can see the
field name in the tooltip when you point to a field on the Fields pane.

6. Save the chart or report.

Your content is now available as an Auto Link target.

Running an Auto Link Enabled Chart

Auto Linking is supported from any Db2 Web Query repository content, wherever it is run
online.

Example: Launching an Auto Link Enabled Report

From the Db2 Web Query Hub or the Db2 Web Query Home Page, right-click a chart that is Auto
Link enabled, and then click Run.
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Example: Using Hyperlinks to Link to Other Reports or Charts

Use the hyperlinks to link to other reports and charts, based on the following information:

Charts. Displays with aspects over which you can hover (for example, a bar) in the chart. A
tooltip displays with the Auto Link target reports and charts, as shown in the following
image.
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Reports. Values pointing to Auto Link targets display as clickable links. When you click a
link, a menu appears, allowing you to select a target to open, as shown in the following
image.

Adding Drill-Down Links to Content

Drilldowns are a powerful feature that allows users to navigate from one content item to
another, providing access to additional, related information at run-time. Drill-down links can
also be used to pass parameters, so that the target content is automatically filtered for the
value that a user selects, allowing you to maintain context between items. By linking content
with drilldowns, you can vastly expand the amount of information that is available from a single
chart or report.

In a report, drill-down links are provided as hyperlinked values. In a chart, drill-down links are
executed when you click a section of the chart. When you add multiple drill-down links to a
single field, you can select one from the tooltip menu that results when you click a report
hyperlink or point to an area of a chart.

You can create different types of drill-down links to connect to different types of target items.
You can use the link to open a selected content item or page, connect to a URL, or execute a
JavaScript function.
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To create drill-down links for a field, right-click a field in any bucket of a report, or in the default
measure bucket of most chart types, and click Configure drill downs. The Configure Drill Downs
dialog box opens, as shown in the following image.

To create a drilldown, click the plus icon. Next, determine the type of content that you want to
link to. The information that you provide to create the drilldown differs depending on the target
type.

Select Content/Page to link to another procedure, such as a chart or report, or to a page.
Select the item from your Db2 Web Query repository, and choose where it should load. You can
load the target content in a new window or browser tab, the same window as the current item,
or you can specify a window or frame by name.

Note: Drill-down links are functional at design time. When the drill-down target location is
Current Window, clicking a drill-down link in the canvas opens the target in a new browser tab
or window so that Db2 Web Query Designer can stay open. When you run your content,
drilldowns with a target location of Current Window load in the window where the drilldown was
accessed.

You can also configure the drilldown to pass parameter values to the target item. If the target
uses dynamic parameters, such as prompted filters, matching parameters with the same name
are automatically created to pass the value that a user clicks. The selected value will be
applied to the target content when it loads.
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To manually add parameters to pass through the drilldown, click the plus sign in the
Parameters section of the Configure Drill Downs dialog box. First, provide a parameter name,
which should match the names of amper variables in the target content. Using the menu in the
Type column, set whether the parameter should pass field values, a static value that you set,
or the value set for a global variable in your environment. Finally, select a field, enter a value,
or select a global variable to pass. You can automatically create all parameters in the target
content by clicking Add all target filters, or create parameters for all sort fields in your parent
content – that is, the chart or report that you are currently editing – by clicking Add all group
fields. You can then delete individual parameters if you want, or delete all parameters by
clicking Clear List. Drill-down parameter options are shown in the following image.

To link to a web page through a URL, select the URL radio button. The URL must include the
protocol, for example, http or https, if it is an external link. Otherwise, the URL will be
interpreted as a partial URL within your Db2 Web Query environment.

Next choose where the target URL should load, whether in a new window, the same window, or
elsewhere. Finally, add any parameters. If you add parameters, they are appended sequentially
to the end of the URL as key-value pairs using a GET request in the following format:

?parameter_name1=value1[&parameter_name2=value2 ... 
&parameter_namen=valuen]

where:

parameter_name1, parameter_name2, parameter_namen 

Are parameter name values, specified in the Parameter Name column of the Configure Drill
Downs dialog box.

value1, value2, valuen 

Are parameter values. They can be field values passed from the report, or static values.
The field or static value is specified in the Field/Parameter/Value column of the Configure
Drill Downs dialog box.
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The question mark (?), ampersands (&), and equals signs (=) are added to the URL
automatically, so you do not need to include them when setting up the drilldown.

To execute a JavaScript function from the drill-down link, select the JavaScript radio button. In
the JavaScript Function text box, supply the name of the JavaScript function. The function and
the arguments that it accepts must already be defined for the function to work. You can define
custom JavaScript functions in a .js file on your environment, which you can create using the
text editor or upload from your machine, then reference that file using the SET JSURLS
command. This command can be applied globally by adding it to edasprof.prf on the Db2 Web
Query Reporting Server, so the functions in the file are always available to whoever has
access. Alternatively, you can add the SET JSURLS command to the Preprocessing Other
component of a Reporting Object, then use it as the data source for your content.

In the Request Parameters area, add each argument, in order, as a separate row. These
arguments can be static values, by setting the Type column to Value, or dynamic field values,
by setting the Type column to Field. Once the type is set, enter the value or select the field
whose value should be used as the argument.

You can manage your drilldowns from the pane at the left side of the Configure Drill Downs
dialog box. You can create multiple drilldowns that you can access from the same hyperlink in
a report or the same area of a chart. To create more drill-down links that you can select from
the same location, click the plus sign above the list of drilldowns in the Configure Drill Downs
dialog box, as shown in the following image.

When you click a link in a report or an area of a chart that includes multiple drilldowns, a menu
appears, listing them all.

Note: The menu for multiple drilldown links on a single field does not display if a report is
created as part of a page. They display properly for charts, stand-alone reports, and reports
added to a page as external content.

To rename a drilldown link, double-click the title in the drilldown list, and type a new title.
These titles appear in the tooltip in your content when selecting a drilldown to execute. Drag a
drilldown using the handles to the left of the drill-down title to change the order in which your
drilldowns appear.
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If you want to remove a drilldown, click the X next to its name. To remove all drilldowns, click

Remove All Drill Items .

Procedure: How to Pass Parameter Values to a Page

You can drill down from a chart or report to a page created in Db2 Web Query Designer. Drill-
down parameters can be passed to the page to apply their values to any page filters.

1. Create and save a page that includes prompted filters. These filters can be created by
adding parameterized external content to an assembled page and clicking Add all filters to
page on the Filters tab of the sidebar, or can be created in a page with new content by
dragging a field to the Filter toolbar.

The filters in this page will be populated with values passed from a drill-down report.

For information on creating a page, see Creating Pages.

2. Create a new report.

On the Db2 Web Query Hub or the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens.

3. Select the same data source that was used to filter the page, and click Select.

The Db2 Web Query Designer canvas appears.

4. Create a chart or report that is sorted by the same fields that are used as filters in the
page. For example, if the page is filtered by Customer Business Region and Sale Year,
create a report with those fields in the row bucket. Add other measures and dimensions to
your content based on your needs and preferences.

5. Determine the measure field in a chart, or any field in a report, to which to add drill-down
links.

If you are passing multiple parameter values through the drilldown, selecting a field in the
chart or report with additional sort values under it may help clarify to the user which values
will be passed.
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For example, in the report shown in the following image, the Sale Year field is the
secondary sort field while Customer Business Region is the primary sort field, so each row
in the Sale Year column represents a sale year and a business region.

In this case, adding the drill-down links to the Sale Year column would allow you to choose
from all of the available Customer Business Region and Sale Year values, whereas adding
the links to the Customer Business Region column would only allow you to pass parameter
values for the first sale year in each business region group. As an alternative to creating
drilldowns on the lower level sort field, you could ensure that all parameter values are
passed from a report by using repeating sort values. On the Content picker, select the Grid
report layout option.

6. Right-click the field to which you want to add drill-down links and click Configure drill
downs.

The Configure Drill Downs dialog box opens.
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7. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on
the left.

The Content/Page drilldown type, which we are using to drill to a page, is selected by
default.

8. In the Content/Page Path text box, click the file icon to select the page that you want to
drill to.

Notice that the Parameters grid is automatically filled based on the filters in the selected
page.

9. In the Load In area, select the location where the target page should run. It can be the
same window where the report was run, in a new browser tab, or a user-specified location.

10. In the Parameters section, check whether the parameters that you want to pass have
already been added. To add a new parameter, click the plus icon, and proceed with the
following steps.

a. In the Parameter Name column, type the name of the parameter. Typically, this
matches the field name. You can check the parameter names used in an assembled
page by clicking the Info button.

b. From the Type menu, choose whether the value to pass should be a field value,
associated with the link that a user selects, the value of a global variable defined in
your environment, or a constant value.

c. If you selected Field, use the Value menu to select a field from your content. If you
selected Constant, type a constant value to pass to the page.

11. Repeat step 11 for all parameters whose values you want to pass to the target page, or
click the X in the right-most column of the Parameters grid to remove unneeded
parameters.

12. Double-click the default drill-down name, for example, Drill Item 1, to change the name of
the drilldown. This name appears in the tooltip when you point to a drill-down link, or click
a link that includes multiple drilldowns.

13. Click Apply to create the drilldowns.

In a report, drill-down links are added for each value of the field where the drilldown was
created. In a chart, drilldowns are added to each section.

14. Run the chart or report.

15. At run-time, drill down to the target page.

If you created a chart, click a section of the chart. If there are multiple drilldowns,
select the drilldown that you just created.

If you created a report, click a drill-down link. If that field of the report has multiple
drilldowns associated with it, select the drilldown that you just created.
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16. The page opens in a new browser tab or window. Notice that the value or values
represented by your selection in the parent content item are applied as filter values in the
page.

Procedure: How to Pass a Global Variable Value Through a Drilldown

A global variable is a variable that maintains its value for the duration of a Db2 Web Query
session or until a different value is assigned. Global variables are identified by double
ampersands. As opposed to local amper variables, which you can pass different values
through a drilldown to filter target content based on the value that you select, the best use for
global variables is to maintain a single consistent value as you run different content items. In
this example, we will set a global variable to the current date, allowing us to filter target
content for that date value by invoking the global variable.

The advantage of using a global variable is that its value is not contingent on the content item
that is passing it. A local variable, when passed through a drilldown, must be set in the parent
procedure, so a field must be added that contains values that the local variables can pass.
This is not the case for a global variable, which is set externally to the procedure. However,
since the global variable is not set by the procedure that passes it, the drill-down value that
you select will not affect the value that is passed, unless the global variable is set to be
dependent on a local variable.

The drill-down parameter options in Db2 Web Query Designer provide a list of global variables
that are already defined in your environment, so the first step is to set the global variable
value. Next, you can create target content filtered by a field that can accept that value, and
finally you can create the drill-down content that will pass the global variable to the target.

1. On the Db2 Web Query Hub or the Db2 Web Query Home Page, click Workspaces to open
the Workspaces area.

2. On the Action bar, click Other, and then click Text Editor.

The New Text Resource dialog box opens.

3. Click FOCEXEC (fex) to create a new Db2 Web Query procedure using the text editor.

This procedure will set a value for a new global variable.
The text editor opens.

4. In the text editor, type the following:

-SET &&CURRDATE = &YYMD;
-TYPE &&CURRDATE
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The first line sets the value of a new global variable, &&CURRDATE, to today's date,
represented by &YYMD. &YYMD is a system variable that always returns the current date
in a YYMD (year-month-day) format. You can change CURRDATE to whatever you want,
since it is just the name of the global variable that you are creating.

The second line displays the value of the global variable, &&CURRDATE in this example,
as text in the output using the -TYPE command, so you can make sure that it has been set
properly.

Click Preview  on the text editor toolbar. A new window opens with a message showing
the result of the executed procedure. There is no actual output, but it should show the
current date in YYMD format under the Detail area.

The global variable is now set for the duration of the Db2 Web Query session. To ensure
that the variable is always set when a user signs in, an administrator can set this
procedure to run automatically using a setting in the Db2 Web Query Administration
Console. To configure this setting, complete the following steps:

1. Save the procedure that sets the global variable and return to the Db2 Web Query Hub
or Home Page.

2. In the Workspaces area, navigate to the location where you saved the procedure. Right-
click it and click Properties.

3. Copy the value of the Path property, which is the IBFS path of the procedure that sets
the global variable value in your environment.

4. On the Db2 Web Query Hub, click the Management Center and then click Administration
Console. Alternatively, on the Db2 Web Query Home Page banner, open the Settings
menu and then click Administration Console.

The Db2 Web Query Administration Console opens.

5. In the navigation pane on the Configuration page of the Administration Console, click
Other.

6. Paste the path of the procedure that sets the global variable value into the Paths to be
executed on user Sign-in field.

7. Click Save.

When a message appears indicating that the new setting has been saved successfully,
click OK and close the Administration Console.

5. Create a content item that will be the target of a drilldown that passes the global variable.
We will create this item first since we need to be able to select a target item when we
create the drilldown.

In this case, since the global variable that we have created is set to a date value, we will
want to create target content that is filtered by a date field.

1. Creating Reports

Creating Reports  157



Create a new chart or report.

Db2 Web Query Designer opens, and you are prompted to select a data source.

6. Navigate to and select a data source that includes a date field with data for the current
date, and then click Select.

The Db2 Web Query Designer canvas displays.

7. From the field list, drag a date field to the Filter toolbar to create a dynamic parameter
filter. You do not need to select values for this filter control, since they will be supplied by
the global variable.

The date control in Db2 Web Query Designer provides a date range, so when we pass the
global variable to the filter parameter, we will pass it as both the start and end date to
filter our content to show data for just the current date.

8. Add fields to your content, and, optionally, change the content type and add more
parameter filters. You can also add more content items to create a page by clicking
Convert to page, and then dragging a field or container onto the page. All items on this
page are affected by the filter controls on the Filter toolbar. You can use drilldowns to
pass local parameter values to these filters alongside the global variable value that we will
pass.

When you are finished creating the target content, click Save.

9. Create a new chart or report that will include drill-down links that pass the global variable
that we configured to our target item.

On the Db2 Web Query Hub, click the plus menu and then click Create Visualizations, or,
on the Db2 Web Query Home Page, click Visualize Data.
Db2 Web Query Designer opens, and you are prompted to select a data source. If you
added any filters in addition to the one that will receive the global variable value, you
should use the same data source as your target item.

10. Change the content type and add fields to create a content item to which you will add your
drilldowns. If you added any filters to the target item in addition to the one that will receive
the global variable, you should make sure that the fields used for those filters are added
to this content item.

11. Right-click a dimension field in a report or a measure field in chart and click Configure drill
downs.

The Configure Drill Downs dialog box opens.

12. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on
the left.

The Content/Page drilldown type, which we are using to drill to the target content item, is
selected by default.
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13. In the Content/Page Path text box, click the file icon to select the item that you want to
drill to.

Notice that the Parameters grid is automatically filled based on the filters in the selected
page.

14. In the Load In area, select the location where the target page should run. It can be the
same window where the report was run, in a new browser tab, or a user-specified location.

15. In the Parameters section, check whether the parameters that you want to pass have
already been added. Parameters for start and end dates for a date range filter should
appear automatically since the filter was created in the target item.

For both of these parameters, complete the following steps:

a. From the Type menu, select Global variable.

A drop-down menu appears in the Field/Value column.

b. In the Field-Value column, select the global variable that you defined earlier.

16. Repeat these steps for the second date parameter. Filters for date fields create ranges
with a start and end date. by default. By setting these to the same date limits the date
range to a single day.

17. Set values for any other parameters in the target report by specifying the field whose value
should be passed based on the value that you select to execute the drilldown, or a static
value that you always want to pass.

18. Click Apply to create the drilldowns.

19. On the Visualization toolbar, click Run in new window to run your content and test the
drilldowns.

20. Execute a drilldown. It should run the target content, which should be filtered for the
current date as specified by the global variable that was passed.

21. If everything works as expected, return to Db2 Web Query Designer and save your content.

Procedure: How to Drill to a Webpage From a Selected Value

When you pass parameters using a URL drilldown, they are sent using GET requests. You can
use this functionality to access different web pages based on the value that you select from
your content.

In this example, we will use a URL drilldown to open a Wikipedia article for the country that we
select.

1. In Db2 Web Query Designer, create a chart or report using a field with country names as a
sort field.

2. In a chart, right-click a measure field or, in a report, right-click the field to which you want
to add drill-down links, and then click Configure drill downs.
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The Configure Drill Downs dialog box opens.

3. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on
the left.

4. Change the Type of the drilldown to URL.

5. In the URL text box, type the root URL to which the GET request will be added. For this
example, type https://en.wikipedia.org/w/index.php.

A question mark, followed by the parameter name and value, will be appended to this URL.

6. Optionally, change the target location of the URL from Self, which opens the target URL in
the same window or tab as the drill-down chart or report, to New Window, which opens the
target URL in a new tab or window, or Window/Frame, which opens the URL in a user
specified container.

7. Add a new parameter to the drilldown.

a. Click the plus sign icon under Parameters to add a new parameter.

b. In the Parameter Name column, type the name of the parameter. The URL that we are
using in this example accepts a parameter called title, which is the name of the
Wikipedia article to open.

c. Leave the Type column set to Field. We want to pass dynamic field values through the
URL drilldown so that the value that we click is reflected in the article that opens on
click.

d. Select the field whose value you want to pass. For this example, select the country
field that you added to your chart or report.

8. Optionally, in the pane on the left, double-click the default drill-down name, for example,
Drill Item 1, and type a new name for your drilldown. This name appears in the tooltip
when you point to a drilldown link in a report, or when there are multiple drilldowns on a
single field.

9. Click Apply to create the drilldown.

10. Click Run in new window to view your content at run time.

11. Click a hyperlink in a report or a section of a chart. The Wikipedia article opens for the
value that you clicked.

Procedure: How to Execute a JavaScript Function From a Drilldown

You can trigger a JavaScript function when using a drilldown in your content. The parameters
defined when setting up the drilldown are used as the arguments in the JavaScript function.
This simple example uses the alert function, which requires no special setup or configuration,
to display the dimension field value that a user clicks.

1. In Db2 Web Query Designer, create a new chart or report and add at least one measure
field and one dimension field.
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2. In a chart, right-click a field in the default measure bucket, or in a report, right-click the
field to which you want to add drill-down links, and click Configure drill downs.

The Configure Drill Downs dialog box opens.

3. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on
the left.

4. Change the Type of the drilldown to JavaScript.

5. In the JavaScript Function text box, type alert, which is the name of the function used in
this example. It opens a pop-up window displaying the value of the first argument as text.

6. Add a new parameter to the drilldown.

a. Click the plus sign icon under Parameters to add a new parameter.

b. To display a field value in the alert message, leave the Type column set to Field.
Change the Type to Value to always display the same value in the alert.

c. Select the field whose value you want to pass. It can be a measure field or a
dimension field.

7. Optionally, in the pane on the left, double-click the default drill-down name, for example,
Drill Item 1, and type a new name for your drilldown. This name appears in the tooltip
when you point to a drilldown link in a report, or when there are multiple drilldowns on a
single field.

8. Click Apply to create the drilldown.

9. Click Run in new window to run your chart or report.

Your content runs in a new browser tab or window.
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10. Click a hyperlink in a report or a section of a chart. An alert appears, displaying the value
that you selected, as shown in the following image.

Procedure: How to Execute a Custom JavaScript Function From a Drilldown

With some additional configuration, you can execute a custom JavaScript function from a
drilldown link. This provides significant flexibility in defining what occurs when a drill-down link
is clicked. In this example, we have created a JavaScript function that opens a mailto URL,
dynamically populated with an email address and first name from our data source. The first
name will be added to the subject line of the email. Since the email address in a mailto URL is
not supplied as a key-value pair, we cannot do this using a URL drilldown.

1. First, define the custom JavaScript function using the text editor.

a. On the Db2 Web Query Hub or the Db2 Web Query Home Page, click Workspaces.

b. On the Action Bar, click the Other tab, then click Text Editor.
The New Text Resource dialog box opens.

c. On the Web tab, click JavaScript (js).

The text editor opens.

d. Enter the code for your JavaScript function.

In this example, the function to generate a mailto URL is called fnMail, and is coded
as follows:

function fnMail(Email,Name)
{
window.location = 'mailto:' + Email + '?Subject=Hello, ' + Name;
    }
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The two parameters that we will need to supply from the drilldown will be the email
address, for the Email argument, and the first name, for the Name argument.

e. Save the new JavaScript file to your Db2 Web Query Repository.

2. Create a new report using Db2 Web Query Designer.

3. In Db2 Web Query Designer, select a data source that includes email address and first
name fields.

In this example, we are using the wf_retail_lite.mas Master File, part of a sample dataset
that can be added to your Db2 Web Query environment.

4. On the Content picker, change the content type to a report layout, either the Standard
Report or Grid options.

5. Optionally, add filters to reduce the size of the report and the processing time that it
requires.

6. Add the email address and first name fields to your report.

If you are using the wf_retail_lite Master File as your data source, in the Dimensions area,
expand Customer and then Full,Name, then double-click Email,Address and First,Name.

7. Add one or more measure fields to the report.

8. Right-click a field, for example, the email address field, in one of the buckets, and click
Configure drill downs

The Configure Drill Downs dialog box opens.

9. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the pane on
the left.

10. Change the Type of the drilldown to JavaScript.

11. In the JavaScript Function text box, type fnMail, which is the name that we gave to the
function used in this example.

12. Add the first parameter, which supplies an email address, to the drilldown.

a. Click the plus sign icon under Parameters to add a new parameter.

b. Leave the Type column set to Field. The recipient of the email from the mailto URL
should change depending on the value that we click in the report.

c. Select the field whose value you want to pass. In this case, it is the email address
field.

13. Add the second parameter, which supplies an associated first name, to the drilldown.

a. Click the plus sign icon under Parameters to add a new parameter.

b. Leave the Type column set to Field. The first name shown in the subject of the email
from the mailto URL should change depending on the value that we click in the report.
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c. Select the field whose value you want to pass. In this case, it is the first name field.

14. Optionally, in the pane on the left, double-click the default drill-down name, for example,
Drill Item 1, and type a new name for your drilldown. This name appears in the tooltip
when you point to a drilldown link in a report, or when there are multiple drilldowns on a
single field.

15. Click Apply to create the drilldown.

16. Save the report and exit Db2 Web Query Designer.

17. Finally, we must tell our report request where the custom JavaScript function is defined.
We can use the SET JSURLS command to specify the location of the .js file that we
created earlier. This command can be added to the edasprof server profile so that it is
available to all procedures. This step must be performed by someone with administrative
privileges on the Db2 Web Query Reporting Server.

Note: As an alternative, you can add the SET JSURLS command to the Preprocessing
Other component of a Reporting Object, then use it as the data source for your content.

On the Db2 Web Query Hub, click Management Center and then click Server Workspaces.

Or, on the Db2 Web Query Home Page, open the plus menu and click Prepare and Manage
Data.

In the Db2 Web Query Reporting Server browser interface, open the Tools menu  and
click Workspace.

The Server Workspace view opens.

18. On the resource tree, expand Configuration Files, then right-click Server Profile -
edasprof.prf and click Edit.

19. On a new line, type SET JSURLS=

20. After the equals sign (=), in quotes, add the run-time URL for the .js file in which the
function is defined, then close with a semicolon (;).

The run-time URL uses the following format:

http[s]://hostname:12331/webquery/run/path_to_item

where:

hostname 

Is the name of the system where Db2 Web Query is installed.

path_to_item 

Is the IBFS path of the JavaScript file in your Db2 Web Query repository. You can find
the path of a page by right-clicking it on the Db2 Web Query Home Page and clicking
Properties. The file path is listed as the Path property.
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Slashes (/) between folder names should be retained literally instead of encoded in
the URL, and the colon (:) should be removed after IBFS. For example:

http[s]://hostname:12331/webquery/run/IBFS/WFC/Repository/
My_Workspace/~user/custom.js

The full SET JSURL command may resemble the following:

SET JSURLS='http[s]://hostname:12331/webquery/run/IBFS/WFC/Repository/
My_Workspace/~user/custom.js';

21. Save your changes to edasprof.prf

22. Return to the Hub or Home Page and run your report, then click a drill-down link.

A new email opens with the To address and Subject line already filled, with different values
depending on the link that you click.

Procedure: How to Use a JavaScript Drilldown to Run a Chart or Report in a Target Panel on a Page

You can use a specific, pre-configured JavaScript function called portalDispatch to drill to a
target chart or report, and run it an a specified target container on a page. This target
container can be identified by a CSS class, which you can set using the Classes property for
the content area within a container. The target container can be a basic panel container with a
single content item, or a multi-content container, such as a tab, accordion, or carousel
container, that contains multiple items. If the content area that contains the target item is part
of a multi-content container, then it becomes visible immediately when the drilldown is
executed. For more information on setting and using CSS classes, see Styling Pages With
Custom CSS. The target chart or report, which you evoke to run in the target container, is
referenced using the IBFS path, which you can find in the Path field when viewing the
properties of an item on the Hub or Home Page. You can pass multiple items to multiple
containers listed in sequence, and you can also pass the values of multiple fields from a
single drill-down link to multiple parameters in the target item or items.

First, create one or more target charts or reports that you want to run when a drill-down link is
clicked. You can add dynamic parameter filters to these items so that they are filtered based
on the selected drill-down link. Next, create a chart or report with a drilldown that executes a
JavaScript function called portalDispatch. The function arguments determine what items are
run, and where they should run. Finally, assemble a page that contains the drill-down content
and containers in which the target content can run. You must also ensure that the
portalDispatch JavaScript function is recognized, by specifying the location of the .js file that
contains it on the Db2 Web Query Reporting Server.

1. First, create one or more target charts or reports using Db2 Web Query Designer.
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In order to receive parameter values from your drilldown, the target content must have
single select filters. Filters created in InfoAssist are single select by default, while those
created in Db2 Web Query Designer are multi-select by default, meaning that you must set
them to accept a single filter value for them to accept passed parameter values.

a. On the Db2 Web Query Hub or Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens, where you are prompted to select a data source.

b. Select the data source that you want to use. You should use the same data source for
the target content and the parent content containing the drill-down links.

c. Create your target content by adding fields to the appropriate field containers, and
applying your preferred customizations and styling options.

d. Add prompted filters to your content, allowing it to be filtered based on the selected
drill-down link. The field or fields used to filter the target content should be used as
sort fields in the parent content that contains the drilldowns.

Drag a field from the Data pane to the Filter toolbar. Optionally, select default values
for your filters.

Repeat these steps to allow the target content to accept multiple parameters from a
drill-down link.

e. Make all of the prompted filters in your target content single select. Right-click each
alphanumeric filter prompt and click Single.

f. Save the target chart or report.

g. Repeat steps 1a through 1f to create multiple target charts and reports. The
portalDispatch function can invoke and pass parameters to multiple charts and
reports at once.

2. Create the chart or report that will contain the drill-down links that run the target item or
items created in step 1.

a. On the Db2 Web Query Hub, open the plus menu and click Create Visualizations, or, on
the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens, prompting you to select a data source.

b. Select the data source that you want to use. This should be the same data source
that you used for the target content in step 1.

c. Create the drill-down parent content, which can be either a chart or report, by adding
measure and dimension fields to the appropriate buckets.

The dimension fields that are used as dynamic parameter filters in the target content
should be used as sort fields in the parent content.
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d. Add drill-down links to your content. If you are creating a report, right-click a sort field,
and if you are creating a chart, right-click a measure field. From the shortcut menu,
click Configure drill downs.

The Configure Drill Downs dialog box opens.

e. Create a new drilldown by clicking the plus sign, Create New Drill Item, icon in the
pane on the left.

f. Select the JavaScript radio button to create a drill-down link that executes a JavaScript
function.

g. In the JavaScript Function text box, type portalDispatch. This is a pre-existing function
that has already been defined in a file in the default Db2 Web Query installation.

h. In the Request Parameters, click the plus button (+) to provide values of arguments in
the JavaScript function. Each one occupies its own line in the parameter table. You
will add at least 6 parameters, with extra parameter-field pairs if you want to pass
multiple parameter values to the filters you set up in the target content.

Specify the following parameter values in the JavaScript drilldown:

1. Add a new parameter and change the Type to Value using the drop-down menu in
the Type column. In the Field/Value column, type drillRefresh.

2. Click the plus button again to add another new parameter. Change the Type to
Value and type self in the Field/Value column.

3. Add another new parameter. Change the Type to Value, and type the name of a
CSS class that will identify the content area of the panel in which the drill-down
target content will run.

For example, if you type panel1 in the Field/Value column when configuring the
drill-down parameters, you will need to add panel1 to the Classes property of the
content area of the container in the page where the drill-down content will run.

You can run multiple content items to multiple containers from the same drill-down
link, in which case the class names should be separated by spaces. For example,
panel1 panel2.

4. Add another new parameter. Change the Type to Value, and type or paste the IBFS
path of the target content that you created in step 1.

To find the IBFS path of an item, right-click it on the Hub or Home Page and click
Properties. The IBFS path of the item is listed in the Path field. You can copy it to
paste into the Field/Value column when configuring the parameter for the target
content.
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If you want to run multiple content items, separate them with spaces. The order of
the paths should be coordinated with the order of the container classes specified
in step 2h3. The first listed target item runs in the container with the first specified
class, the second listed item runs in the container with the second specified class,
and so on.

This value is not necessary if the procedure that you want to refresh is present in
the container content area with the class specified in step 2h3. If this is the case,
you may omit this argument of the drilldown and proceed to step 2h5.

5. Add another new parameter. Change the Type to Value, and, in the Field/Value
column, type the name of the parameter used to filter the target content. By
default, this is the name of the field.

6. Add another new parameter. Leave the Type as Field, and, in the Field/Value
column, select the field associated with the parameter name provided in step 2h5.

7. If the target content has multiple dynamic parameter filters, repeat steps 2h5 and
2h6 to supply the other parameters as name-field pairs.
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8. Once you have added all parameters to the drilldown, your drill-down configuration
may resemble the one shown in the following image.

Click Apply to generate the drill-down links in your chart or report.

Your content now executes the portalDispatch JavaScript function when you click a
value that includes drilldowns.

i. Save your content and return to the Hub or Home Page.

3. Create a page to which you will add the content containing the drill-down links that you just
created, and enough additional panels to run the content items that you set to run when a
drilldown is executed, based on step 2h4.

On the Hub or Home Page, click the plus button and then click Assemble Visualizations.

Db2 Web Query Designer opens, allowing you to create a page from existing content.

4. You are first prompted to select a page template. You can select one of the preset
options, or select Blank to add your own containers to the page.
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The Db2 Web Query Designer canvas opens.

5. Assemble the page where you will be able to load the target content created in step 1
after clicking a drill-down link in the item created in step 2.

a. With the Content tab selected on the sidebar, navigate to the item that you created in
step 2, and drag it into a container or an empty area of the page.

The item with the drilldowns displays on the page. Resize it as needed.

b. Add a container for each drill-down target item created in step 1. The container can be
empty, or contain an item that will be replaced with the drill-down target item. If you
selected a page template, there may be containers available already. Note that you
can have these items run in separate tabs, accordion panels, or slides of multi-
content container.

c. Select the content area of a target container by clicking inside it. On the Settings tab,
in the Classes text box, type the name of the first class that you defined in step 2h3.

If the content area that you select is part of a tab, accordion, or carousel container,
then when you execute the drilldown, the container immediately updates to display the
target item.

Repeat this step for any additional contains in which you want to run other content
items, specified in step 2h4, using the class names defined in step 2h3.

6. Now that the content has been added and the containers have their classes set, save the
page.

7. Finally, we must tell our report request where the custom JavaScript function is defined.
We can use the SET JSURLS command to specify the location of the .js file in the Db2
Web Query installation that includes the portalDispatch funciton. The SET JSURLS
command can be added to the edasprof server profile so that it is available to all
procedures. This step must be performed by someone with administrative privileges on the
Db2 Web Query Reporting Server.

Note: As an alternative, you can add the SET JSURLS command to the Preprocessing
Other component of a Reporting Object, then use it as the data source for your content.

a. On the Db2 Web Query Hub, click Management Center and then click Server
Workspaces.

Or, on the Db2 Web Query Home Page, open the plus menu and click Prepare and
Manage Data.

In the Db2 Web Query Reporting Server browser interface, open the Tools menu 
and click Workspace.

The Server Workspace view opens.
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b. On the resource tree, expand Configuration Files, then right-click Server Profile -
edasprof.prf and click Edit.

c. On a new line, type SET JSURLS = '/webquery/tools/portalcanvas/iframeinterface.js'

The partial URL points to the location in your Db2 Web Query installation where the
portalDispatch JavaScript function is defined.

d. Save your changes to edasprof.prf

8. Now that the JavaScript function is enabled, return to the Hub or Home Page, and run the
Db2 Web Query Designer page. Right-click the page, and click Run in new window.

The page runs in a new browser tab. Click a drill-down link in the parent item created in
step 2. One or more target items, created in step 1, run in another container on the page.
These items are also filtered based on the value that you clicked, since you specified the
parameter name and field when setting up the JavaScript function.

9. Optionally, click more drill-down links to update the filter values applied to the target
content, or click the Refresh button on the page toolbar or container menu to reset the
contents of the page.

Changing Output Formats in a Chart or Report

The output format of your content determines the type of file that is generated when that
content is run. Different output types enable different levels of run-time interactivity,
embedding behavior, and compatibility with outside programs, so you can change the output
type depending on how you intend to use your content and who the intended audience is.

You can change the output format for stand-alone charts and reports. Charts and reports
created as part of a multi-content visualization use the Interactive output format, which
provides run-time features such as tooltips, drill-downs, and on-chart filtering.
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To change the output format of a stand-alone chart or report created in Db2 Web Query
Designer, use the Output Format menu on the Visualization toolbar. The Output Format menu
is shown in the following image:

The following output format options are available:

AHTML

HTML5

HTML

PDF

PPTX

XLSX

Select at runtime
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At design time, the AHTML and HTML5 output formats use the responsive canvas. When using
the responsive canvas, reports present In-Document Analytic paging controls at the bottom of
the canvas that allow you to navigate through the pages of report. Some report styling
properties are unavailable when using the responsive canvas. Charts in the AHTML and HTML5
output formats present informational tooltips and allow on-canvas filtering at design time.

The HTML, PDF, PPTX, and XLSX output formats use a paginated canvas at design time. Some
report styling properties are only available when using the paginated canvas. You can scroll
through an entire report using a scrollbar. Charts using the paginated canvas do not present
interactive options, such as tooltips.

At run time, the HTML5 and HTML output formats are functionally equivalent. The two options
are available to allow you to use the two different canvas types.

When you run your content, the HTML, HTML5, and AHTML options are browser-based formats,
while PDF, PPTX, and XLSX output can be downloaded, distributed, and opened using standard
office suite software. The Select at runtime option provides the ability to run a chart using any
of the other output formats. Users can select a format at runtime from a filter control.
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When creating a chart, the HTML and HTML5 output formats generate a basic chart, enhanced
with JSON objects, that can be run in a web browser. The HTML and HTML5 chart formats
automatically generate tooltips for different sections of a chart, allowing you to see detailed
information at run-time on top of the quick, broad intuitions that a chart communicates. These
tooltips provide run-time access to interactive features such as Auto Drill, which allows you to
drill into data hierarchies used in the chart, and Auto Linking, which allows you to connect
content that uses shared parameters associated with sort fields in the chart. The following
image shows a chart that uses the HTML5 output format and has Auto Drill and Auto Linking
options available from the tooltip.

The HTML5 format also enables you to run your chart with Insight, which allows you to modify,
filter, and reformat a chart at run-time.
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When creating a report, meanwhile, the HTML and HTML5 output formats generate a basic
report that can be run in a web browser. The simplicity of the HTML and HTML5 output formats
make them extremely flexible. Run-time interactivity is available in the form of hyperlinks, which
provide access to Auto Drill and Auto Linking. An example of an HTML report with Auto Drill
hyperlink behavior is shown in the following image.
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Charts and reports using the AHTML format can also be run in a web browser. AHTML is a
format that allows you to perform offline analysis using in-document analytic features. The
AHTML format allows you to use Auto Drill and Auto Linking functionalities just like HTML. In
addition to this, AHTML enables numerous features that allow you to reorganize and explore
the data in an analytic chart without directly accessing the data source on which it is based.
This includes the ability to filter the chart by lassoing values, view the data in the chart as a
different chart type using the Chart Types menu, and create a new chart using the same fields
while still in run time, download the chart, and more using the Options menu. An analytic chart
with the Chart Types menu open is shown in the following image.

Changing Output Formats in a Chart or Report

176 



When the AHTML format is used in a report, in addition to the Options menu above the report,
you can click a column header to filter the report, view the data in the report as a chart, and
more. A menu of options appears, allowing you to explore and transform the report, as shown
in the following image.

You can also click the arrows above each column header to sort the report by the values in
that column.

When a chart or report using the AHTML output format is added to an assembled page, the
Options menu becomes part of the container toolbar. It allows you to access the Chart/Rollup
Tool to create new content from the same set of fields used in the original content, move the
fields in a chart to different buckets, export, save, or print your content, and more.

To access your content in common desktop tools, use the PDF, PPTX, or XLSX output formats.

When you run content that uses PDF, PPTX, or XLSX as the output format, a file is created in
a .pdf, .pptx, or .xlsx format, respectively. The file opens in a browser viewer for that file type
or is downloaded in the browser. The file can be opened using a tool compatible with the
output file type. When the item is a chart, an image of the chart is embedded in the file. If the
tool allows it, you can then right-click the image of the chart to save it as a separate image file.

Certain features may not be available, depending on the file type. For example, the PDF, PPTX,
and XLSX output formats do not support Auto Linking, Auto Drill, or any other tooltip-based
behavior, since a single, self-contained file is created.

Separate pages generated by page breaks or by the MultiPage bucket also behave differently,
depending on the output file type. In PDF, a separate page is created for each page break or
multipage value, and in PPTX, a separate slide is created. In Excel, however, separate pages
are output to the same worksheet, similar to how page breaks and multipage values display in
the HTML output format.
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The following image shows an example of a chart created using the PDF output format viewed
in a web browser.

The following image shows an example of a chart created using the PPTX output format viewed
in Microsoft PowerPoint 2007.

Changing Output Formats in a Chart or Report

178 



The following image shows an example of a report created using the XLSX output format
viewed in Excel 2007.

You can use the Select at runtime option to enable any of these output formats. When content
using the Select at runtime option is added to a visualization as external content, a filter
control appears at the top of the page, allowing you to select an output format at runtime.
Items on the page that use Select at runtime are re-run in the selected output format. The
Select at runtime option does not appear by default, but administrators can enable it from the
InfoAssist Properties page of the Administration Console by selecting the User Selection check
box in the Format Tab section.
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Overview of In-Document Analytics

Setting the output format of a stand-alone chart or report to AHTML provides In-Document
Analytic capabilities at run-time. Content that uses In-Document Analytics provides users with
an interactive interface that allows the generation of real-time, dynamic charts and reports. Its
versatility not only allows you to interact with your content by adding filters, sorting data, and
generating new content, but it also allows for offline content access. You can package a data
set with a combination of analytical views, resulting in highly intuitive and interactive self-
service business intelligence. This gives you an edge in presentation and analysis, making it
easy to develop and share concepts, ideas, and scenarios. An interactive report is a self-
contained report, meaning that it contains all the data and JavaScript® within the HTML output
file. Packaging the data and the interactive functions in the HTML file also makes the output
highly compressible for email and transparent to security systems. If you are working with a
larger data set, you can also zip the output files to reduce the file size when sending them
through email.

Note: You may need to zip interactive content output files to reduce the file size, and send
them through your email client.

Your users can explore and interact with your data using various analytical tools such as
sorting, filtering, calculations, roll-ups, and pivoting. They can also experiment with different
scenarios using various options.

All of the interactive content that you create functions independently of a server, and is
portable, making it easy for your users to work with and analyze complex data without requiring
the use of an external application, such as Microsoft Excel. With two types of users (developer
and end user), the roles in development and delivery of materials are clear. The end user
interacts with the content that the developer creates and deploys. They can obtain content
without any additional plug-ins or programs should they choose to access your content
remotely or offline, independent of a server.

Note: Each artifact that you create at run time is given a unique number for easy identification.
This number is incremental but not consecutive, and is assigned automatically.
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When you run content using an AHTML output format, you can review and continue to develop
it using the available menus. For example, when you run a chart, you can select the chart
menu to change the type of chart you are showing, as shown in the following image.

1. Creating Reports

Creating Reports  181



To add a new chart or edit your content, you can use the options available from the vertical
Ellipsis menu, which is shown in the following image.

When you view your report or chart at full screen, a hamburger menu also displays, as shown
in the following image. From this menu, you can exit full screen, save changes, or restore the
dashboard.
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Generating a Data Extract or Image From Content

In addition to the output formats that you can use when running your content, you can export a
snapshot of a single chart or report as a data extract in an Excel spreadsheet, or as a .png
image, which are downloaded from your browser. This allows you to quickly generate a
representation of your content at any time, in a format that can be easily saved and
distributed.

To generate the image or data extract, click the Application menu and, in the Export As section,
click Data or Image. The file is downloaded using your browser.

When you export a data extract of your chart or report, it is downloaded as an Excel
spreadsheet with the data displayed as a tabular report. This can help identify the precise
values that are graphically represented in your chart. A spreadsheet is also easy to distribute.
The following image shows part of the spreadsheet created by exporting a treemap chart as a
data extract.
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When you export an image, a snapshot of the item is taken as it currently exists, and saved
in .png format. Headers, footers, and legends are included in the image, but external items
such as filter controls are not. The following image, showing a treemap chart, was exported
directly from Db2 Web Query Designer.

Once exported, you can open the image using a program on your machine capable of
opening .png images, distribute the image, and even use it as a thumbnail for your content
once you save it. To set a thumbnail, right-click the saved chart or report on the Db2 Web
Query Hub or Db2 Web Query Home Page and click Properties. On the Advanced tab, select the
Embedded thumbnail option and browse to the location where the exported image was saved.
The thumbnail makes it easier to identify a content item on the Hub or Home Page, or in the
Resources tree when assembling a visualization in Db2 Web Query Designer.
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Previewing Content

As you create content and pages in Db2 Web Query Designer, you can preview them to see
how your data displays in the chart, or to check the styling, run-time behavior, and filtering
before publishing or sharing it with others. At any point in the development of your

visualization, click Run in new window .

Clicking Run in new window runs the visualization in a new browser tab, allowing you to view
your content at run-time while continuing to edit it in a separate window. If you click Run in new
window again, the content is reloaded in the same new tab.

Once it is saved, you can also run your content from the Db2 Web Query Hub or Db2 Web
Query Home Page by right-clicking it and clicking Run.

When you preview stand-alone charts and reports that contain required filter prompts, you are
presented with an Autoprompt page. You can use the filter controls to set values for each
filter, as shown in the following image.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT
IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software
Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, FOCUS, iWay, Omni-Gen, Omni-HealthData, and
WebFOCUS are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation and/or its affiliates.

All other product and company names and marks mentioned in this document are the property
of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the
readme file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S)
DESCRIBED IN THIS DOCUMENT AT ANY TIME.
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THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.
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